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Introduction

Citrix XenApp™ is the on-demand application delivery solution that enables
any Windows application to be virtualized, centralized and managed in the
datacenter and instantly delivered as a service to users anywhere on any de-
vice. XenApp reduces the cost of application management by up to 50 percent,
improves application and data security and enables you to Simplify IT, Opti-
mize delivery of virtual applications, and Accelerate business with efficiency.

Amazon Elastic Compute Cloud (Amazon EC2) is a web service that pro-
vides resizable compute capacity in the cloud. It is designed to make web-scale
computing easier for developers. Amazon EC2’s simple web service interface
allows you to obtain and configure capacity with minimal friction. It provides
you with complete control of your computing resources and lets you run on
Amazon’s proven computing environment. Amazon EC2 reduces the time re-
quired to obtain and boot new server instances to minutes, allowing you to
quickly scale capacity, both up and down, as your computing requirements
change. Amazon EC2 changes the economics of computing by allowing you
to pay only for capacity that you actually use. Amazon EC2 provides develop-
ers the tools to build failure resilient applications and isolate themselves from
common failure scenarios.

When these two powerful technologies come together, amazing simplicity,
scalability and efficiencies of scale are made possible. By utilizing Amazon
EC2, XenApp administrators can quickly build and deploy XenApp farms
in the cloud to meet capacity demands, or simply grow an infrastructure at a
lower cost of ownership.

This guide will walk through the steps to deploy a complete XenApp applica-
tion farm in Amazon EC2 to meet the demands of a production IT depart-
ment.
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Solution Requirements

Production XenApp Farm running in Amazon EC2 Cloud

Secure Communications between Client and XenApp Web Interface using Secure Gateway

Prerequisites

Citrix XenApp 5.0

Citrix XenApp 5.0 Update 3 (optional)

Amazon EC2 account

Windows Server 2008 R1 Sp2 - Domain Controller, Active Directory, DNS (citrixlabs.com)
Windows Server 2008 R1 Sp2 - Citrix License Server (CTXSlic1.citrixlabs.com)

Windows Server 2008 R1 Sp2 - Citrix Web Interface/Secure Gateway (wi.citrixlabs.com)
Windows Server 2008 R1 Sp2 - Citrix XenApp Server 1 (xas1.citrixlabs.com)

Windows Server 2008 R1 Sp2 - Citrix XenApp Server 2 (xas2.citrixlabs.com)

Windows Server 2008 R1 Sp2 - Citrix XenApp Server N

Additional Information

http://aws.amazon.com

http://console.aws.amazon.com


http://flexcast.citrix.com/
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Network Diagram

The following is the Network that was used to develop this deployment guide.

Citrix XenApp ma  AmazonEC2

“Amazon EC2”
Logical Network Diagram

\i
~
~
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Connect to EC2:

Open a web browser and
connect to:

http://aws.amazon.com/ec2/

Connect to EC2:
Navigate to the EC2 console:

http://console.aws.amazon.
com/

Amazon EC2

Create AMI

CiTRIX

Amazon Elastic Compute Cloud (Amazon EC2) is a web service that provides
resizeable compute capacity in the cloud. It is designed to make web-scale
computing easier for developers. In order to setup a XenApp farm in EC2,
you will need to sign up for the Amazon EC2 service.

Amazon Elastic

O cxao

https fans. amazon. com/ec2/

Amazon Elastic Compute Cloud (Ama...| +

~
ama Sign in to the AWS Management Console Create an AWS Account English
webservices®
AWS Products p c Support Account
Products & Senvices - Amazon Elastic Compute Cloud (Amazon EC2)
Amazon EC2 Details Amazon Elastic Compute Cloud (Amazon EC2) is a web service that Sign Up For Amazon EC2 ()
provides resizable compute capacity in the cloud. It is designed to make
EC2 Overview web-scale computing easier for developers.
E=l P Amazon EC2's simple web service interface allows you to obtain and
EC2 Pricing configure capacity with minimal friction. It provides you with complate
control of your computing resources and lets you run on Amazon's
Amazon EC2 SLA proven computing environment. Amazon EC2 reduces the time required
I - to obtain and boot new server instances to minutes, allowing you to
nstance Types
o quickly scale capacity, both up and down, as your computing
EC2 Instance Purchasing reguirements change. Amazon EC2 changes the economics of computing
Options by allowing you to pay only for capacity that you actually use. Amazon
EC2 provides developers the tools to build failure resilient applications
Reserved Instances :
and isolate themselves from common failure scenarios.
Spot Instances
Windows Instances This page contains the following categories of information. Click to jump down:
Amazon EC2 Functionality Pricing
Amazon EC2 Features Service Highlights Resources
£ n. s

Done

AWS Managem

O cxae

AWS Management Console

amazon
webservices”
AWS

Related Services
Amazon EC2
Amazon CloudWatch
Elastic Load Balancing
Elastic Block Store
Amazon CloudFront

Amazon Elastic MapReduce

Related Resources

Documentation
Articles & Tutorials
Developer Tools
Public Data Sets

Amazon Machine Imagss

onsole - Mozilla

http: ffaws.amazan. com/consalef

+

Sign in to the AWS Management Console

AWS Management Console

A Web-based Interface to Manage Your Services

Access and manage Amazon's growing suite of infrastructure web
services through our new point-and-diick, web-based user interface. The

Support

Create an AWS Account

English

Account

Already have an AWS account?

Sign in to get started.

AWS Management Consale gives you a quick, global picture of your doud
computing environment so that you can see what resources yuu’re EC2
operating and conveniently manage those resources.

Making AWS Simpler to
Access and Use

The AWS Management Console
provides a graphical user interface
for Amazon EC2, Amazon Elastic
MapReduce, and Amazon
CloudFront, with additional Amazon
infrastructure services scheduled to
be added to the console in the
coming months.

Sign in to the AWS Console {3

v

e this

O sav
Amazon Elastic Amazon
Amazon EC2 MapReduce CloudFront
- [ h
Region:  [BE Usast » | | || @Launch

» EC2 Dashboard

NST:

» Instances

Viewing: | All Images
AMI ID
@ ami-00220769

O @) ami-005db069
# @) ami-005dbatg

3 Rogister New AMI

%) (Al Platforms

Manifest

level22-ec2-images/ubuntu-7.04-feist
alestic-64/ubuntu-8.04-hardy-base-64

rouilder-online/new-example-1-x85_6

>

http: f/aws. amazon. comfconsole
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6 - G Xt [ ntws:iconsoe.aws.amazon.confecthome i B

5]
28~ Goos P
| AWS Management Console + B
Nl aws.amazon.com AWS | Products | Developers | Community | Support | Account Welcome, Citrix Test | Settings  Sign Out
Amazon Elastic Amazon
Amazon EC2 H MapReduce ‘ CloudFront ‘
Amazon EC2 Console Dashboard
Region:  |E ysgast v —
Getting Started = My Resources =

» EC2 Dashboard
You are using the following Amazon

INSTANCES To start using Amazon EC2 you will want to EC2 resources in the US East
launch a virtual server, known as an Amazon (virginia) region:
> Instances EC2 instance.

> Spot Requests

@ 17 Running Instances @ 5 Elastic IPs
Launch Instance
IMAGES

% 19 EBS Volumes 17 EBS Snapshots

Note: Your instances will launch in the US East ® 11 Key Pairs @ 7 Security Groups
> Bundle Tasks (Virginia) region.

> AMIs

2 0 Load Balancers
ELASTIC BLOCK STORE

> Volumes Service Health =
> Snapshots

Links =

Current Status Details

Documentation
NETWORKING & SECURITY ) ‘Amazon EC2 (US East- N. Service is operating

> Elastic IPs virginia) normally > All EC2 Resources
> View complete service health details
» Security Groups 2 > Forums
> Key Pairs > Feedback B

> Load Balancers

Report an Issue <

@ 2008 - 2008, Amazon Web Services LLC or its affiliates. Al right reserved. Feedback Support Frivacy Policy | Termsof Use AN amazoncom. compary

Done

g

%) AWS Management Console - Mozilla Firefox

6 - X D hrm‘fl home #c=EC28s=L.

Request Instances Wizard

O
CHOOSE AN AMI
Choose an Amazon Machine Image (AMI) from one of the tabbed lists below by clicking its Select button.

m My AMIs || Community AMIs

Basic Fedora Core 8 (AMI Id: ami-84db39ed)
Minimal Fedora Core 8, 32-bit architecture, and Amazon EC2 AMI Tools.

fedord®

6 Basic 64-bit Fedora Core 8 (AMI Id: ami-86db39ef)
fedora Fedora Core 8, 64-bit architecture, and Amazon EC2 AMI tools

Getting Started on Microsoft Windows Server 2008 {(AMI Id:
ami-69c3200)

fJ\Mndows Microsoft Windows Server 2008 R1 SP2 Datacenter edition, 32-bit
architecture, Microsoft SQLServer 2008 Express, Internet Information
Services 7, ASP.NET 3.5.

fJ‘M § Basic Microsoft Windows Server 2008 (AMI Id: ami-45c22e2¢)
Microsoft Windows 2008 R1 SP2 Datacenter edition and 32-bit architecture.

:]Wi § Basic 64-bit Microsoft Windows Server 2008 (AMI Id: ami-cdc22ea4)
Microsoft Windows 2008 R1 SP2 Datacenter edition and 64-bit architecture.

Microsoft SQLServer 2008 on Windows Server 2008 (AMI Id:
ami-2bc32f42)

Microsoft Windows Server 2008 R1 SP2 Datacenter edition, 64-bit
architecture, and Microsoft SQLServer 2008 Standard.

£ windows

Launch Instance:

Once you have logged into the
Amazon console, you will see
the dashboard.

Select Launch Instance.

Choose an AMI:

Navigate to the Amazon
Machine Image (AMI) that
Getting Started on Microsoft
Windows Server 2008.

At the writing of this document,
the AMI Id was: ami-69c32f00.

Sometimes Amazon updates
their AMI’s so this Id could
change.
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AM I Deta 1 I s: ?) AWS Management Console - Mozilla Firefox

A 77 -] [$8- ceosle
Number of Instances: 1

Availability Zone: No Preference

Size: Small

Request Instances Wizard

Cancel %/
CHOOSE AN AMI INSTANCE DETAILS

Provide the details for your instance(s). You may also decide whether you want to launch your instances as "on-demand” or
"spot” instances.

Number of

flability Zone:

Small (m1.small, 1.7 GB) -

Continue.

Instance Type:

® Launch Instances

EC2 Instances let you pay for compute capacity by the hour with no long term commitments. This transforms what are
commonly large fixed costs into much smaller variable costs.

O Request Spot Instances

Done

AM I Details: %) AWS Management Console - Mozilla Firefox

)’ A home #c=EC28s=Launc 7 v| @- Google
Kernel ID: Use Default
RAM Disk ID: Use Default
Monitoring: unchecked CHOOSE AN AMI mmun?u:mu

Number of Instances:

User Data: <leave empty> Avallability Zone:

Request Instances Wizard

Cancel [x]

No Preference

Advanced Instance Options

Here you can choose 3 specific kernel or RAM disk to use with your instances. You can also choose to enable Cloudwatch
C t Monitoring or enter data that will be available from your instances once they launch.

Kernel ID: Use Default v
RAM Disk ID: | Use Default +

Monitoring: [ Enable Cloudwatch Monitoring for this instance
(additional charges will apply)

User Data:

O bases4 encoded

Done
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%) AWS Management Console - Mozilla Firefox

home #c=EC28s=L.

77 -] @v Google

Done

Request Instances Wizard

CHOOSE AN AMI INSTANCE DETAILS CREATE KEY PAIR

Cancel (%]

Public/private key pairs allow you to securely connect to your instance after it launches. To create a key pair, enter 3 name and
dick Create & Download your Key Pair. You will then be prompted to save the private key to your computer. Note, you only
need to generate a key pair once - not each time you want to deploy an Amazon EC2 instance.

® Choose from your existing Key Pairs

Your existing Key Pairs*: Citrpc

v

O Create a new Key Pair

O Proceed without a Key Pair

%) AWS Management Console - Mozilla Firefox

home #c=EC28s=L.

77 -] @v Google

Done

Request Instances Wizard

CHOOSE AN AMI INSTANCE DETAILS CREATE KEY PAIR CONFIGURE FIREWALL

Cancel (%]

Security groups determine whether a network port is open or blocked on your instances. You may use an existing security group,
or we can help you create a new security group to allow access to your instances using the suggested ports below. Add
addional ports now or update your security group anytime using the Security Groups page. All changes take effect immediately.

O Choose one or more of your existing Security Groups

® Create a new Security Group

2. Describe your Security Group ‘
3. Define allowed Connections
‘Application Transport Port Source Hetwork (IPv4 CIDR) Actions
RDP tep 3389 Al Internet
MS SQL Server tep 1433 Al Internet
HTTP tep 80 All Intemet
FTES v TcP 443 All Internet Change
A\ No "Application” pratocol selected

, 5

Key Pair:
Key Pair:

If you have already created a
key pair, select it for use.

If you don’t have a key pair yet,
create one.

Key pairs allow you to securely
connect to your AMI after it
launches. With the key pai,
only you have access to the
AMI and the data.

Continue.

Firewall:

Your AMI will be firewalled by
Amazon. You can open up
ports in that firewall using the
Console Interface. You can
create different firewall groups
for use with different AMI’s.

A default group is installed by
Amazon, however many of the
ports you will want to use, are
closed or blocked.

By Default, RDP and HTTP
should be open.

You will want to add a rule to
allow HTTPS port 443, and FTP
ports 20, 21.

Continue.

10



Review:

Review your AMi details, and
Continue to launch it.

My Instances:

You can then view your AMI
being created in the Instances
dashboard.

It will have an initial status of
pending.

Select Refresh, until the status
changes to running.

%) AWS Management Console - Mozilla Firefox

0 c x « GE=Em

CiTRIX

home #c=EC28s=Launc

com [T

Request Instances Wizard

CHOOSE AN AMI INSTANCI

E DETAILS CREATE KEY PAIR CONFIGURE FIREWALL REVIEW

Please review the information below, then click Launch.

AML.

Name:

Description:

: Ay windows AMI ID ami-69¢32f00 (i386)

Getting Started on Microsoft Windows Server 2008

Microsoft Windows Server 2008 R1 SP2 Datacenter edition, 32-bit
architecture, Microsoft SQLServer 2008 Express, Internet Information
Services 7, ASP.NET 3.5.

Number of Instances:

Availability Zone:
Monitoring:
Instance Type:
Instance Class:

Kernel ID:
Ramdisk 1D:

No Preference
Disabled

Small (m1.small)
On Demand

Use Default
Use Default

User Data:

Key Pair Name:

Security Group(s):

citrixvpe

default

Cancel [x

Edit AMI

Edit Instance Details

Edit Advanced Details
Edit Key Pair

Edit Firewall

%) W

6 C % tw [ EEEEE nttpsiiconso aws. amazon.comjec frome #c=EC2ds=Instances

| AWS Management Console

=1

1] “ouurivie

n My Instances
1@ Launch Instance:

Reserved nstances. .

> Snapshots

NETWORKING & SECURITY
> Elastic IPs
> Security Groups

> Key Pairs

> Load Balancers

ing: | All Instances | |All Instance Types e
> EC2 Dashboard sl | i | ‘
Instance AMI ID Root Device  Type Status ~ Lifecycle Public DNS  Security Grot
INSTANCES [ | g 6975070 ami-ba22c0d3 ebs m1.small @ rnning | normal 2c2-184-7357 default A
» Instances = P
] [ i-854afdee ami-f11ff098 ebs m1.small @ running normal ec2-184-73-61 default
> Spot Requests
[0 | i i9147d7a amid6c22e2c ebs m1.small @ stopped | normal default
IMAGES
| [0 i@ ids5a3bbe ami-86db3%ef ebs m1 large @ wnning | normal c2-72-44-52- default
> AMIs ‘|
+ Bundle Tasks m} a i-3b2b565( ami-Bd7a84ed instance-store m1large @ running normal 2c2-184-73-11 default E
i i-2ddcatdt ami-G9c3200  ebs m1.small J pending  normal defaull
ELASTIC BLOCK STORE
> Volumes 0 EC2 Instances selected

Select an instance above

© 2008 - 2009, Amazon Web Services LLC or its affiliates. All right reserved.

Feedback Support Privacy Policy

Terms of Use | AN amazoncom. compary

Done
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Get Password:

home #c=EC 77 -] [$8= cooge
T —— [ Once the AMI status changes
(A [ H
— to running, select the AMI and
|
Region: B USEast v [@ Launch instance || Instance Actions |+ || Reserved Instances | ~ [3 showtide || & Refresh || @ Help navlgate tO Instance AC‘tIOhS ->
Viewing: Inst: M it i i
o o AllInstancs Inccance Hanagemen i \ Get Windows Admin Password.
Instance gﬂt”geci L Status  + Public DNS  Security Groi Key Pair Nan
INSTANCES O i3 i-6975d70: SRR o8 I @ running | ec2-1847357 default citsupe A You will need to provide your
Tnst
: 5"5:"“5 [0 | i i85dafted  Create Image (EBS AMI) I @ nmning | ec21847361 default citriupe .
pot (53 AMI)
O | i@ i-ds5adb ES:‘;IA:E:ZTE;?EW e @ nning  ec2-7244-52 default despakg_yi key’ in order to decrypt the
HAeEs . OO g i-3b2b565 e @ nnning | ec2-184-73-11 default prashanth_ password_
> AMIs i = Instance Actions - B
» Bundle Tasks Fg i-2ddcatad Terminate Il @ running  ec2-204-236-2 default citrixvpe -~ . . .
[0 | i i9147d7f  Reboot Il @ stopped default deepakg_vf o The Key IS Stored N a _pem f||e_
ELASTIC BLOCK STORE Stop
> Volumes 1EC2 Instancese| i . L
h =
» Snapshots i EC2 Insta Cloudwatch Monitoring -
NETWORKING & SECURITY Description Enable Cloudwatch
i Disable Cloudwatch
» Elastic Ips AMI ID: : Zone: us-east-1c
> Security Groups ~ . .
+ Key pairs Security Groups: default Type: m1.small
+ Load Balancers Status: running Owner: 519701941432 3
© 2008 - 2009, Amazon Web Services LLC or its affiliates. All right reserved. Feedback Support Privacy Policy Terms of Use An amazoncom. compary
hitps: jcansale. aws, amazen com/ec2/hame =

Get Password:

77 -] [#8+ cooge

The decrypted password is
random, you need to change it
once you login to the machine.

Retrieve Default

Password decrypted for instance i-2ddca14s

@ Password change recommended. Make note of the IP Address in

We recommend that you change your password to one you will remember and

Voo pevere: the Computer name. This is the

Please note that passwords can persist through bundling phases and will not be

retrievable through this taol. It is thersfore important that you change your pu blic IP Address yOU will use
password to one that you will remember if you intend to bundle a new AMI from .
to connect to the machine.

this instance.

You can connect remotely using this information:

Computer: ec2-204-236-206-219.compute-1.amazonaws.com

User: Administrator

Decrypted
Password:

5Qnu25@L




Connect to AMI:

You will need to run Remote
Desktop Connection to connect
to the desktop of the AMI.

From a Windows command
prompt, run Microsoft Remote
Desktop. From a command
prompt:

mstsc /console

Type in the IP Address of the
AMI, and Connect.

Login to AMI:

Type in the decrypted password
and login to the Windows AMI.

CiTRIX

“) AWS Management Console - Mozilla Firef

AWS Management Console

Done

f/console aws. amazon.com/ec2/home £c=EC28s=Instances

#3 Remote Desktop Connection

Remote Desktop
& Connection

Cancel [%

Computer: [204.236.206.219

Userniame:  None specfied
You will be asked for credertials when you connect

Comnect | Cancel ][ Heb | [ Options >

P2
this instance.

You can connect remotely using this information:

Computer: ec2-204-236-206-219.compute-1.amazonaws.com
User: Administrator

Decrypted
Password:

#% 204.236.206.219 - Remote Desktop.

\

Administrator

Cancel

% Windows Server-200s

Datacenter
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#3204.236.206.219 - Remote Desktop

. Terminal Services

7. Component Services

&) betm sourees (O0B0) o cerecs o olher tois o manage
3] Event Viewer local and remote computers.

3 3 5 Internet Information Services (I15) Manager
"1
% Server Manager ,( 3 d )
g &, I5CST Initiator
o (- i Prompt o — 5y Local Security Policy
|| Memary Diagnostics Tool
= Administrator @ Reliabilty and Performance Monitor
7 Windows Update =
Legg Ta Security Configuration Wizard
“ Coesers hy Server Manager
e Internet Explorer B — B
. serviees
¢ Computer
j otcpas x| Share and Storage Management
/| o
. Network ¥ Storage Explorer
System C
Control Panel (1) Task Scheduler

@ Windows Firewall nith Advanced Security
s Windows Server Backup

Help and Support
Run...

Windows Sequrity

3 Al Programs
IStarl Search l@ (0} a
Distart | 3 om0 |

&8 Computer Management

Fie Acton View Help

€2 A RE =]
& Computer Management (Local)
B [} systemTools T ——
#) (2 Task Scheder nt for guest access to t...
2] Event viewer : Al Tasks. 3 More Actions
i Shared Folders B e —
) ¥ Local Users and Groups Delete
7 Users Rename More Actions
7 Groups o
@ Relizbiity and Performanc
i Device Manager Help
B 2 Storage
(=7 Disk Management
Ey Services and Applcations

Administrator

v

e L |

[Set the user's password [

Costart] | 5, M |[ 2 computer Manageme... ]

Change Password:

The first thing you need to do
is change the password for the
administrator account.

Navigate to Start ->
Administrative Tools ->
Computer Management.

Change Password:

Navigate to System Tools ->
Local Users and Groups.

Select Administrator -> Right-
Click -> Set Password.

14



EC2 Service Properties:

Launch the EC2 Service
Properties configurator:

c:\local disk\program files\
amazon\ec2configservice\
ec2configservicesettings.exe

Set Computer Name: Disable
Set Password: Disable

Enable Set Password after
sysprep: Disable

MS Terminal Services:

Enable Microsoft Terminal
Services.

Navigate to Control Panel ->
Programs and Features -> Turn
Windows features on or off.

From Server Manager select
Add Roles.

Select Terminal Services and
Application Server. Select Next
to install them.

#3 204.236.206.219 - Remote Desktop

Program Files + Amazon ~ Ec2ConfigService ~

* B [searcn

Organize v =ZViews ~ | | Open @

Favorite Links L | -| pate modified |- Type |-lsze  |-|7aes -]
. Docs 2/9/2010 8: 18 AM File Folder
IF) Documents J Logs 2 Service Properties [ O]
B Fictures . Plugins
B music . Settings
1 [#]pisablewWinUpdate
[WEcaconfia
|| Ec2ConfigInstalstate
| EcaConfigiibrary.di
i Ec2c
4] Ec2Rebootinstance. dl
% Ec2SetDnsSuffices.dl
%/ Ec2UMConfigLibrary.di ¥ itiaiize and format al the uninftidized dives attached ta the instance.
ot ephemeral dives (d.e...) are inftitalized by this feature.
e
= sysprep2008
WiD096-16-8

General | Bundie | Drive Mapping |

/ Recently Changed 1~ Set Computer Name

I™ Set the computer name of the instance to ip-<hex Intemal IP> name.
Disable this feature to persist your own computer name setting

[~ Intizlize Drives

[~ Set Password

T~ Set a random password on next boot for start of Ec2Corfig).
This password can be extracted by =2 get password and de-
ed using private launch key. Afterthe passwordis set.
this feature wil be tumed off automatically.

Enable SetPassword feature after sysprep.
I™ This will cause the SetPassword feature to be enabled when
Sysprep is invoked through this utiiy.

—Evert Log

~
Folders T~ Output event log entries onthe console for easy monttoring and
Ec2ConfigServicesettings Date modified: 2/8/20 debugging fromthe cfert
Applcation Size: 56.0KE

Date created: 2/3/20

Setiings

Note: These changes wil take affect on next boot or restart of the ec2conti service.

oK Cancel Apply

#3 204.236.206.219 - Remote Desktop

E. Server Manager

Fie Acon View Help
&= [m]
o e e O e - | M
Rales
i Features
Diagnostics

Gt Configuration -
5 storage

-

Select one or more roles to install on this server.

Roles: Description:

] Active Directory Certificate Services
[] Active Directory Domain Services

[ Active Directory Federation Services
[] Active Directory Lightweight Directory

Application Server

Confirmation
] DHCP Server
[] ons server
Resuilts [ Fax Server
[] File Services
[ Network Policy and Access Services
[] rint Services
Terminal Services
[ upDI Services
Web Server (IIS) (Installed)
[ Windows Deployment Services
[ Windows Server Update Services

Progress

More about server roles

Role Services [ Active Directory Rights Management Services

Application Server provides central

management and hosting of high-

performance distributed business

applications such as those built with

services Enterprise Services and .NET
Framework 3.0.

<previos || Mextz | e Cancel

tion Wizard

Role Admiristration Tools

"% Refresh disabled while wizard in use

Oostart| | 5 m

| £ rogrems and Features [, Server Manager

e
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#3204.236.206.219 - Remote Desktop.

X MS Terminal Services:
. Server Manager

;:T“" few Fep Select the Terminal Services
= Sore Ve [T and TS Licensing roles.

[ 3 Roles
| Features 2
Jm Disgnostics i

[ &5 storage

Before You Begin Select the role services to instal for Terminal Services:
Server Roles Role services: Desaiption: ]
o IS Licensing manages the Terminal
Services client access licenses (TS
O q o CALs) that are required to connect to
N TS Session Broker a terminal server. You can use TS
tion Wizard
CEEE I Bl L] 75 Gateway T e e e " Vi
Authentication Method ] 75 Web Access the availability of TS CALs.
Licensing Mode
User Groups
5 Licensing Configuration
Application Server
Role Services
Confirmation
Progress
Results
L _

More about role services

<previous || Nextz | el Cancel

Role Administration Tools

473 Refresh disabled while wizard in use

{rstan] | 3, | (£ Programs and Features || %, Server Manager

#3204.236.206.219 - Remote Desktop.

: X MS Terminal Services:

IS [=E3
Fie Acion View Help
Py Select the Web Server (IIS)
. e vanese o e - [ Support role.
5 Roles
| Features 2
7 Diagnostics 7' Select Role Services
it Configuration 5
[ &5 storage H
Before You Begin Select the role services to instal for Appiication Server:
Server Roles Role servicss: Description: 1
s e - Web Server (I15) Support enables
Appication Server Foundation Application server to host internal or
Role Services ] = external Web sites and Web services
- COM + Network Access that communicate over HTTP. It
SIEEETE T [] TCP port Sharing includes support for ASP.NET T
Authentication Method = [ Windows Process Activation Service Support applications that canbe accessed via
o HITP Activation aWeb browser such as Internet
Licensing Mode X Explorer, and Web services built using
e G [ Message Queuing Activation Windews Communication Foundation
w5 L] TCP Activation (WCF).
TS Licensing Configuration ] Named Pipes Activation
Sication & B0 Distributed Transactions )
[ 1ncoming Remote Transactions
[ Outgaing Remate Transactions
Web Server (TIS) ] ws-Atomic Transactions
Role Services
Confirmation
Progress
Results
L |
More about role services
<previous || Nextz | el Cancel

Role Administration Tools

473 Refresh disabled while wizard in use

{rstan] | 3, | (£ Programs and Features || %, Server Manager =IC)




Roles:

Select the IS 6 WMI
Compatibility.

Select the FTP Service.

Note: FTP is only required if you

plan on FTP’ing files to your
server for installation.

Alternatively, you can download
FileZilla to the server, and
remove it when finished
transferring files, if you are
concerned about security.

Next.

Install.

Roles:

You may need to reboot the
AMIL.

Once it has rebooted, connect
using Remote Desktop
Connection.

#% 204.236.206.219 - Remote Desktop.
Server Manager

Fie Acon View Help

i Features e\
Diagnostics it

Frogress

Results

IS Management Console (Installed)
115 Management Scripts and Tools (Installed)
Management Service
= [@ 1S 6 Management Compatibility
115 & Metabase Compatibity

] 115 & Saipting Tools

[] 115 6 Management Console
£ [/] FTP Publishing Service
FTP Server

FTP Management Console

More about role services

<previous [ Mext> | mstel

Select Role Services
| Configuration -
5 storage
Before You Begin Select the role services to install for Web Server (1S):
Server Roles Role services: Description:
Terminal Services —7 LS WHIC, provides
Digest Authentication J Windows Management
Role Services. Client Certificate Mapping Authentication Instrumentation (WMI) scripting
115 Client Certificate Mapping Authentication interfaces to programmatically
dEEI R URL Authorization manage and automate tasks for T1S
Authentication Method Request Filtering (Installed) 7.;” Web ““"‘-f;ff“";‘a setof “”Ddts
o that you ereated in the WMI provider.
Licensing Mode 1P and Damain Restrictons This service includes the WMI CIM
o =) erformance (Installed) Studio, WMI Event Registration, WMI
User Groups. Static Content Compression (Installed) Event Viewer, and WMI Object
TS Licensing Configuration Dynamic Content Compression Browsertools to manage sites.
- =[G Management Tools (Installed)

Cancel

tion Wizard

Role Admiristration Tools

"% Refresh disabled while wizard in use

@= (=]
* Roles

Oostart| | 5 m

| [l Programs and Features

|52 Server Manager

#% 204.236.206.219 - Remote Desktop.

Server Manager

Fie Acon View Help

gz

5 storage
Before You Begin
Server Roles
Terminal Services
Role Services
Application Compatibiity
Authentication Method
Licensing Mode
User Groups
TS Licensing Configuration
Application Server
Role Services
Web Server (T1S)
Role Services
Confirmation

Frogress

One or more of the following roles, role services, or features require you to restart:

/1. 4warning messages below

~) Terminal Services

) Application Server

~) Web Server (115)

~ NET Framework 3.0 Features

Print, e-mail, or save the installation report

< Previous

i\ You must restart this server to finish the installation process.
i\ You must restart this server to finish the instalation process.
/1 You must restart this server to finish the installation process.

/I Youmust restart this server to finish the installation process.

Next > | Close

/A, Restart Pending

/A, Restart Pending

/1. Restart Pending

/A, Restart Pending

Cancel

tion Wizard

Role Admiristration Tools

/1. Console cannot refresh until computer is restarted  Restart

= =]
e B
* Roles

i Features e\
Diagnostics +' Installation Results
5} configuration E

-

Oostart| | 5 m

| [l Programs and Features

|52 Server Manager

e
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#3204.236.206.219 - Remote Desktop X
E_Server Manager o] x]

Fie Acion View Help

«= =\
5 Roles

i Features 2
Diagnostics 7 Installation Progress

it Configuration
[ {23 storage 2
Resuming Configuration “The following roles, role services, or features are being installed:

Terminal Services

Reslts ) ties
Application Server
ons
Web Server (I15)
ktop

NET Framework 3.0 Features

tion Wizard
C |
g Collecting installation resuts.
<previous || wext> | [ sl || caneel |
~) Roles: 3of 17installed 3 cotoRoles |

473 Refresh disabled while wizard in use

I [
Lrstart] | 2 m || 55 server Manager ks

Roles:

When you re-connect using
RDP, configuration should
resume.
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Create Volume:

From the Amazon Console,
navigate to Volumes.

Select Create Volume.

Create Volume:
Size: <size of volume>

Availability Zone: <must match
the zone of the AMI created in
the previous section>

Snapshot: None.

Create.

Amazon EBS

Create Volume

CITRIX

Amazon Elastic Block Store (EBS) provides block level storage volumes for use
with Amazon EC2 instances. Amazon EBS volumes are off-instance storage
that persists independently from the life of an instance. Amazon EBS allows
you to create multiple storage volumes that can be mounted as devices to the
AMI. We will create an EBS Volume, to hold the XenApp install data.

77 -] 8- ceosls
I
Region: “ Create volume - 7] [T3 showmide || & Refresn
L EC2 e vi\.ilg:‘A" Volumes \“’” | J€ € 1toz0of20ntems ¥ 3]
Volume ID Capacity Snapshot Created Zone Status Attachmei
INSTANCES . ; ¥
O 5 vol-4a39b23 30GiB snap-aaddbce3 | 2010-02-03 13:31 PST  us-east-1c | @ in-use i-307764%
> Instances - =
» spot O 5 vol-deB948b7 30 GiB snap-ceaadba? = 2010-01-1312:31 PST  us-east-1c | @ in-use i1e7T141
0 & wl7sm321c 30GiB snap-claadba8  2010-02-19 16:33 PST  us-east-lc | @ in-use 297580
IMAGES
.\ AMIs . O 5 vol-a%cabc0 30 GiB snap-Tdbcc01d | 2010-01-06 09:05 PST  us-east-ic = @ in-use i-ds5a3t
> Bundle Tasks O 5 vol-8551fb0c 15 GiB snap-bbaadsd2 = 2010-04-14 22:01 PDT  us-east-lc | @ in-use i-d55a3k
ELASTIC BLOCK STORE [0 5 vol-89ef36en 30GiB snaETAEBBb'e” 2010-03-15 18:02 PDT  us-east-1c @ available >
> Wolumes: 0 Elastic Block Store Volumes selected
> Snapshots Select a volume above
NETWORKING & SECURITY
> Elastic IPs
> Security Groups
> Key Pairs
> Load Balancers
© 2008 - 2009, Amazon Web Services LLC or its affiliates. Al right reserved. Feedback Support privacy Policy | Termsofuse AN amazoncom. compary
Don [ @]
= a

Create Volume

Stee:

Cancel (%]

Availability Zone: | us-east-1c

snapshot: | Na Snapshot —

[@]
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Attach volume

Volume:

Instances:

Device:

vol-c58231ac in us-east-1c

i-2ddcaldb ¥ |in us-east-1c

Windows Devices: xvdf through xvdp
Linux Devices: /dev/sdf through /dev/sdp

04.236.206.219 - Remote Desktop

£ Computer Management

File Acton View Help

O]

o lzmEEIRSE

[ A Computer Management (Local)

Volume [ Layout [ Type [ File System [ Status

[ Capacity [ Actions

& {f} System Tools
() Task Scheduler
{81 Event Viewer
[z Shared Folders
Local Users and Groups
Reliability and Performanc:
Device Manager
= %5 Storage
=4 Disk Management
=y Services and Applications

o (C:) Simple Basic NTFS

Healthy (System, Boot, Page Fil, Active, Crash Dump, Primary Partition) - 30.00 G | picie panagement .

More Actions 3

L_=Disk 0
Basic ()

30.00 GB 30,00 GB NTFS
Online

Healthy (System, Baot, Page File, Active, Crash Dump, Primary Partition)

3IDisk 1

Unknown
20.00GB 20.00 GB
Offine naliocated

4 |_,| W Unallocated [l Primary partiion

[ =iy

Attach Volume:

Instance: <Instance ID must
match the instance you created
in the previous section>

Device: xvdf
Attach.

Prepare Disk:

Connect to the AMI using
RDP, as we did in the previous
section.

Login.

Navigate to Start ->
Administrative Tools ->
Computer management.

Select Disk Management.

You should see the new volume.
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Disk Online:

Select the new disk by clicking
on it once.

Perform a Right-Click on the
new disk, and select Online.

Initialize Disk:

Right-Click again, and Initialize
Disk.

#3 204.236.206.219 - Remote Desktop

e Acton View Help

|

= 5

A Computer Management {Local)
B [} system Tools

(5 Task Scheduler

§2] Event viewer

4 Shared Folders

i Device Manager
= E5 Storage
= Disk Management

Services and Applications

Local Users and Groups
Reliability and Performanc

Volume [ Layout [ Type [ File System | Status.

30.00 GB
Healthy (System, Baot, Page File, Active, Crash Dump, Primary Partition)

Properties

Help

4] | W Unaliocated |l Primary partition ‘

[ capadity [ Actions
5 () Smple Basic NTFS Healthy (System, Boot, Page Fie, Active, Crash Dump, Primary Partition) 30.00 GE | pick Management .
More Actions »

|| & computer Manageme...

Fie Acion View Help

o A

= [} systemTools
() Task Scheduler
§2] Event viewer
i Shared Folders
Local Users and Groups

é Reeliabiity and Performanc
i Device Manager
= 5 Storage

= Disk Management
% Services and Applications

4] | 3]

A Computer Management {Local)

30.00 GB
Healthy (System, Baot, Page File, Active, Crash Dump, Primary Partition)

Not Initialize
Offine

Properties

Help

W Unallocated || Frimary partition |

Volume [ Layout [ Type [ File System | Status. [ capadity [ Actions
5 () Smple Basic NTFS Healthy (System, Boot, Page Fie, Active, Crash Dump, Primary Partition) 30.00 GE | pick Management .
More Actions »

|| & computer Manageme...

e
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#3204.236.206.219 - Remote Desktop.

&8 Computer Management

Fie Acton View Help

P G
& Computer Management (Local) | Volume [ Layout [ Type [ Fie System [ Status. [ capadity [ Actions
E {} systemTools s (C:) Simple Basic NTFS Healthy (System, Boot, Page File, Active, Crash Dump, Primary Partition)  30.00 G¢ | picte Management .
) (2) Task Scheduler
{8 Event viewer More Actions 3
i Shared Folders
Local Users and Groups
% Reliabiity and Performanc
i Device Manager
B 5 storage
=4 Disk Management
s Services and Applcations

4 | |
L =Disk 0
Basic (©)
30.0068 30,00 GB NTFS
Oriine Healthy (System, Boot, Page File, Active, Crash Dump, Primary Partition)
L_Disk 1
Basic
20,0068 2000068
Online nallocated
feyy Spaned Malume .
few Striped Yolume .,
fewy Mirored Yolume, .
ey RAID-5 Yo, .
Properties
Help
4 | +| | M Unallocated |l Primary partiion |
{rstan] | 3, |[ & computer Manageme... Sils

#3204.236.206.219 - Remote Desktop EEIX

&9 Computer Management
Fie Acton View Help

eI

B!

& Computer Management (Local Volume [ Layout [ Type [ File System | Status. [ Capacity [ Actions
S 1] syenross Blicwsmpievahmewizard £ [ pe— R
) (2) Task Scheduler
{8 Event viewer Assign Drive Letter or Path More Actions 3
& Shared Folders For easier acoess, you can assign a dive letter or drive path to your parttion
Local Users and Groups
% Reliabiity and Performanc
i Device Manager
B 5 storage
&
S DiskManagement & Assign the following diive letter: D x

=4 Services and Applications
£ Mount in the following empty NTFS folder

Brawse,

1 Do not assign a dive letter or dve path

Kl Il
£
5
3
4 <Back Nex > cancel |
LTOISK T
Basic
20.00 6B 20,00 GB
Orline inallocated
q | | | M Unalocated | Primary pation |
| |
{rstan] | 3, |[ & computer Manageme... s

New Volume:
Select the Unallocated space
by clicking on it once.

Right-Click, then select New
Simple Volume.

New Volume:

A wizard will appear. Follow the

prompts to create and format
the new disk.

Assign a drive letter, and the
disk is ready to use.

Note: Store all installation
files for XenApp on this new
drive. That way, you can take
a snapshot of it, and attach it
to other AMI’s that you create
later, for your XenApp farm.
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Connect:

Connect to the AMI using
Remote Desktop Connection.

Start -> Run -> mstsc /console

Open a web browser and
connect to the Citrix.com ->
Downloads site.

Download:

Download XenApp 5 Feature
Pack 3 for Windows 2008 iso
image.

Also download the XenApp 5
Feature Pack 3 for Windows
2008 zip file.

CiTRIX

Citrix XenApp

Download the Installation Media

It is necessary to download the XenApp installation media, and store it on the
EBS we created in the previous step. We will later on take a snapshot of that

volume and use it to install the other servers in the XenApp farm.

EEYE DR

itrix Systems » Citrix Downloads

i Favorites | 5, @ Sucgested Sites = ] Web Sice Gallery =

| | T v B - 0 @m v Page~ Safety~ Tooks~ @~

CiTRIX

Home > Support > Downloads

Craig Ellrod > 1D: 3
My Profile

Access your applications and utlties from
anywhere in My Cirix

»

Support
Knowledge Center
» Customer Service
‘Subscription Advantage
» Software Support Programs
» Software Maintenance
» Appliance Maintenance
Tech Support Programs
Education
» Security & Compliance
» Consulting
Open a Support Case
» Product Lifecycle
Downloads
Product Activation
Support Contacts

Eallaw Piériv an-

Products & Solutions  Downloads  Support  Partners  News

The downloads you need in one, easy place.

Select your product and then narmow your search by version, operating system or download type to find
exactly what you need. If you are looking for a Citrix XenApp Client, select XenApp then refine your
results by platform

Search Downloads by Product
[setectone =

Citrix Clients
Download Plug-ins
and Clients.

XenApp 6

Get the latest software
for your edition of

XenDesktop 4
Evaluation
Deliver desktops on

XenApp 6. demand, simply and
cost-effectively.
LEARN MORE @ DOWNLOAD © LEARN MORE ©

8 Log Out

Looking for
Citrix Receiver?

DOWNLOAD HERE O

Featured Downloads

Citrix Essentials for
Microsoft Hyper-V
Evaluation

XenApp 6.0 Enterprise
Edition

XenApp 6.0 Platinum Editon

Evaluation Virtual Appliance
for XenApp 5.0

Merchandising Server 1.2 -
Virtual Appliance

Access Gateway 4.5 -
Advanced Edition Hotfix 5

Access Gateway Enterprise
Edition 9.1

EdgeSight for XenApp 5 and
EdgesSight for Endpoints 5

Vinrkfiow Stidin

tr

{D-1868c1-pov18631538c2=sot362 | | | | | | | Intenet | Protected Mode: OFf

Lisan| | Lm &

| & computer Management

| (€ Gitrix Systems » Citi...

Fas

enApp 5 Feature Pack 3 Platinum Edition - Windows Internet Explorer

18631518productid=186ac1= = G || B[ |42 || x| [&¥ Lve searcn

g Favories |43 @8 Suggested Sites + ] Web Sike Gallery -

Drstart| | 3, W &

| & computer Management

|[@ Gitrix systems » citri.

trix Systems > Citrix Donnioads » — XenApp » XenA. | 3 - [ - ) dm - Page- Safety - Toos - (@~
foma = Suppad > Dowmloads » —Xenkpp » Xenpp 5 Feature Pack 3 Plainum Edion =
Craig Ellrod >> ID: 3 = o
Wy Profile XenApp 5 Feature Pack 3 Platinum Edition Related Documents
CE o Gy s
=1 e
Back to results O Gatoway
Access your applications and utiiies from
XenApp C tive Matrx
anywhere in My Gitrix Cilrix® XenApp™ Feature Pack 3 brings enhancements ta both Microsoft Windows Server e
c aToolbox [9 2008 and 2003 platforms offering customers more value in their existing environments
Support
Knowledge Center General Documentation
» Customer Service Citrix eDocs Library
Subscription Advantage
» Software Support Programs English
» Software Maintenance
» Appliance Maintenance XenApp 5 Feature Al 3124M0  185GB  ap Downioad O
Tech Support Programs Pack 3 for Windows ~ Languages
Education Server 2008 and
» Security & Compliance 2003
» Consulting Contains the Feature Pack 3 updates for the Windows Server 2008 and 2003 platforms, including Single
Open & Support Case Sign-on, Profile Management, License Server Monitoring, Offline and Online plug-ins, and Web
» Product Lifecycle interface. Base XenApp 5 install required.
Downloads
Product Activation XenApp § for English  3/24/10  136GB .iso Download _©
Support Contacts Windomre Server
2008
Follow Citrix on:
_ XenApp 5 for English 3124110 334GB  .iso Download ©
nQuB Windows Server
2003
Installation Manager All 12/3/08 NIA Get Software @ =
o ad=1868ci=z| | | | | | |@h Intenet|Protectsd Mode: OFF [Fa- "% -~ /

[ =
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¢ Gitrix Systems » Citrix Downloads » -- XenApp » XenApp 5 Feature Pack 3 Platinum Edition - Windows Internet Explorer

ciTl

(>
o/

About the Download Manager

The Download Manager provides for more effective, more efficient file
downloads than you normally see with your broswser, especially for

. citr y [detai 156315 Lsproductid=tseaci= =] & || B[ %] | [&¥ Lve searcn |2

B3 7 Download Manager - Windows Internet Explorer 1ol
3 cigix [ htp:idonnioad.citrix.comedgeste.netj4509XAS_FP3_PLT ML12p?_gda_~1272361 =

5 - E) - [ #=h - Page- Safety - Tooks - @~

Cire BlogOut ||

ownloads ~ Support  Partners  News

LClC [ P1eEL08 1 SR i R T [ Qe EUCT| 096 of XAS_FP3_PLT_MLL.zip from ..oad.citrix.com.edgesuite.... =] X
turn your computer off and on again. _

:' ria E: security warning and after you accept o Related Documents

WErell  install and begin to download the req == <]

. @
WAL| Click to download vour file now. ~ ¥As FP3 AT M =& [seoren
e

Accest Organize + Views v | | New Folder

amun | Shonld the Download Manager fl & E¥insedumeil - 0o e o @

security certificate, you can clicl here T["‘m‘”“e | Favortelinks Name = | -] pate modified | -] Type [~lsze -]

the download ot “This folder is empty.

ke manag I Close this dial B Desktop
s % Computer

UpPE [/ Documents

Know )
+ Custd B Pictures

Subst B Music
» Softw | Recently Changed
> Saftw B Searches
" e | Puble

aucs | || | | [ intemmet | Protected Mode: OFF
» Security & Compliance 2003 Folders ~

» Consulting

Contains the Feature P
Open a Support Case 5“;':‘_;: fpr:ﬂ‘:;:;ig:: File name: |><A5_FP3_FLT_ML1 |
» Product Lifecycle interface. Base XenApp ! Save as type: ICumprEssEd (zipped) Folder H
Downloads
Product Activation
XenApp 5 for
Support Contacts Windows Server (= Hide Folders Cancs!
2008 Vi
Entlas: Aisriv an: |
[ [T [ [ @ mtemet|protected Mode: off [fa - [Rw% - A
Costart| | 2 M @ | A Computer Management | Server Manager | & citix systems » GirixD... | @ Donrioad Manager -wi... |[& 0w ofxas_res_piT_. | il

%% 184.73.197.3 - Remote Desktop

22 SlySoft Virtual CloneDrive - Windows Internet Explorer

©) = 8 i/
(1SN T

g Favorites |53 @8 Suggested Sites + 2] Web Sice Galkry +

dysoft.comenvirtual-donedrive. html

B slySoft Virtual CloneDrive

VIRTUAL CLONEDRIVE
Home
Products.
» AnyDVD
+ ANYDVD HD

» ClaneDVD

+ CloneDVD mobile
» ClonecD
+ Gama Jackal Pro

Virtual CloneDri
drive, however
CloneDVD or Cl
b your hard-disk
CloneDrive manner as insel

» Game Jackal Enterprise
Features

+ Supports all common image

Download

Purchase

FAQ

Tutorials
System Requirements
» An IBM-compatible personal

Support

Contact

Forum recommended)

Windows 7 (32 or 64 bit)
+ If you use Windows 2000 or

Probably the best virtual drive software, Virtual CloneDrive allows
you to enjoy the freedom of a virtual drive and is completely free.

» Supports up to 8 virtual drives at the same time
+ Easy to use - just double-click an image file to mount as a drive
+ Virtual CloneDrive is freeware, you may use it at no cost.

microprocessor (1 GHz recommended) and 128 MB RAM (256 MB

+ Windows 98, Windaws ME, Windows 2000, Windows XP, Windows Vista or

=[] 4] ] 8 e searcn

CLONECD  fame

ive works and behaves just like a physical CO/DVD
it exists only virtually. Image files generated with
loneCD can be mounted onto a virtual drive from
or from a network drive and used in the same

rting them into a normal CD/DVD drive.

formats such as 150, BIN, CCD

computer with a minimum 500 MHz Pentium-class

Windows XP you must be an administrator te install

attp: fanww.slysoft. com/en/download. htmi

Costart]| | G M0 @ @ | [fgseare Gateway 3.2 | 3 Seaure Gateway Configu... || 2 SlySoft Virtual CloneD... « Wyl

[ [ [ | mtemet | protected Mode: off [%a - [®wo% -~

Download:

Note: You may have to enable
downloads in Internet Explorer.

Tools -> Internet Options ->
Security (tab) -> Internet ->
Custom level -> Downloads ->
File Download.

Download the file and save

it to the EBS Volume. In this
example, we assigned it drive
letter D:

Once downloaded, unzip the
installation media.

Note: If you wish to conserve
disk space, hence reduce the
cost of storage, you can leave
it zipped, and unzip it when
you attach the volume to each
server AMIL.

Virtual DVD Drive:

Download and install Virtual
Clone Drive from Slysoft.

We will use this program to
mount the XenApp Installation

iso media, to perform the install.

You mount the XenApp iso
image installation media by
Right-Clicking on the iso image,
then Mount with Virtual Clone
Drive.

The XenApp install media
can be see as a drive letter in
Computer.
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Create Snapshot:

From the Amazon EC2
Dashboard, select Snapshots.

Highlight the volume created
earlier.

Select Create Snapshot.

Create Snapshot:

When the Snapshot is 100%
complete, make note of

the Snapshot ID for future
reference.

In this example, our Snapshot
ID is snap-7ec06016.

We will use this to create

volumes, and attach them to
the other servers, to perform
installation tasks for XenApp.

CiTRIX

Amazon EBS
Create Snapshot

Amazon EBS provides the ability to create point-in-time snapshots of your
volumes that are then stored in Amazon S3. These snapshots can be used as
the starting point for new Amazon EBS volumes. We will take a snapshot of

our D: volume, so that we can use the XenApp install media on other AMTI’s
in the farm.

anagement Consol \ozilla Firefox

GVCOQW

nsole. aws. amazon. com/ec 2 home Sc=EC: l
AWS Management Console | =] B
N aws.amazon.com AWS | Products | Developers | Community | Support | Account Welcome, Citrix Test  Settings  Sian Qut
Amazon Elastic Amazon
Amazon EC2 | MapReduce ‘ ‘ CloudFront |
Region: BE s East v %% Create Volume ] %3 Detach Volume [5 showmide | & Refresh | '@ Help
ing:| All Volumes hd I { 1to 21 of 21 Items ]|
> EC2 Dashboard Viewing| I | SIS 2
Volume 1D Capacity  Snapshot Created + Zone Status Attachmer
INSTANCES O 3 volf112cb93 30 GiB snap-558f133c | 2010-03-15 2031 PDT | us-east-lc | @ in-use 1697574
> Instances X
O % vol-dbaT01b2 30 GiB snap-7d5f4914  2010-03-25 1221 PDT  us-east-lc | @ in-use i-B54aft
> Spot Requests .
O 5 vol-8541eeec 0GB snap-de4615b7  2010-04-07 10:13 PDT  us-east-lc | @ in-use 314747
IMAGES -
AMI O % vol-6551b0c 156 GiB snap-bbaadsd2 = 2010-04-14 22:01 PDT  us-east-1c | @ in-use i-d56a3k
> AMIs H
» Bundle Tasks O % wl43aeld2a 30GiB snap-cffa2%a6  2010-04-26 08:36 PDT  us-east-1c @ in-use i-2ddcal
. vol-ch8231ac 20 GiB = 2010-04-26 10:53 PDT  us-east-1c @ in-use i-2ddcaly
ELASTIC BLOCK STORE
> Volumes 1 Elastic Block Store Volume selected i
> Snapshots % Elastic Block Store Volume: vol-c58231ac
NETWORKING & SECURITY Description
> Elastic IPs .
_ VolumeId: @ vol-c58231ac Capacity: 20 GiB
»> Security Groups =
N Created:
Key P: Snapshot: -
» ey pairs Tapete! 2010-04-26 10:53 PDT
> Load Balancers . L. s e
© 2008 - 2008, Amazon Web Services LLC or its affiliates. All right reserved. Feedback Support Privacy Policy Terms of Use ‘An amazon.com. company
Done

7
2]

AWS Management Console - Mozilla Firefox

El

6 - @ [ EEE rtwsiconsoe. aws.amazon.com/ecfhome #c=EC28s=Snapshots 7 -]

AWS Management Console

B aws.amazon.com AWS | Products | Developers | Community | Support | Account Welcome, Citrix Test  Settings | Sign Out

Amazon Elastic Amazon
Amazon EC2 | MapReduce CloudFront ‘
B USEast - 73] create Snapshot ; (T2 showmide || & Refresh || @ Help
jings | Owned By M v 1€ < £ 1
> EC2 Dashboard Viewing | Ouned By Me I | ¢ € 1wisofisrems > >
Snapshot ID Capacity = Description  Status Started Progress
INSTANCES ] nap-064e356f 30 GIB Created by Cre: @ completed ~ 2010-01-11 15:24 PST available (100%) A~
> Instances
] nap-d74833be 30 GIB Citrxi XenApp T @ completed ~ 2010-01-11 15:07 PST available (100%)
> Spot Requests
[} nap-d3fddiba 30 GiB Created by Crez @ completed =~ 2010-02-19 16:58 PST available (100%)
IMAGES
AMI | d0 nap-d5fadfbc 30 GiB Created by Crez @ completed ~ 2010-02-19 16:58 PST available (100%)
> AMIs H
» Bundle Tasks [} nap-4745deZe 30 GiB Created by Crez @ completed =~ 2010-03-16 01:11 PDT available (100%)
snap-4aaalf22 20 GiB XenApp5sp3 ' pending 2010-04-26 13:16 PDT 2%
ELASTIC BLOCK STORE
> Volumes 0 Elastic Block Store Volume Snapshots selected
> Snapshots Select a snapshot above to view information about it here
NETWORKING & SECURITY
> Elastic IPs
> Security Groups
> Key Pairs
> Load Balancers
© 2008 - 2003, Amazon Web Services LLC or its affiliates. All right reserved. Feedback Support Privacy Policy Terms of Use An amazon.com. comparg

Done

3
]
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Create Image:

On the Amazon EC2
Dashboard, select Instances.

Select the instance we have just
been working with.

Right-Click, or select Instance
Actions -> Create Image (EBS
AMI).

Create Image:

Instance ID: <automatically
assigned by Amazon>

Name: XenApp Base Image

Description: XenApp Base
Image.

Create Image.

Make note of the AMI Id.

In this example: ami-4743ad2e

27

CITRIX

Amazon EC2
Create Base Windows AMI

After you have created the initial Windows 2008 server, create a volume, cop-
ied the XenApp install media to it, and snapshotted it, you can create a base
image to use to spawn instance of each of the XenApp farm servers.

With this base image, we will create individual images for use as a Domain
Controller and XenApp servers.

Z) AWS Management Console - Mozilla Firefox

7% -] [~ ceose

.‘ aws.amazon.com AWS | Products Developers | Community = Support | Account Welcome, Citrix Test  Settings Sign Out
Amazon Elastic Amazon
SmazonEC2 || CloudFront |
Region: i# Launchnstance || Instance Actions | = || Reserved Instances  ~ [3 showmide | & Refresh
. Viewing:| Al Instances || All Instance Types | |
Instance AMIID Type Status Public DNS Key Pair Na Launch Time ~ W
INSTANCES - ~ . a
O h- i-f39¢c2298 ami-69c32f00 m1 small D terminate citrixvpc 2010-04-27 1507 PL =
> Instances - 1
» Spot O [ 40463896  amic74falee  mi.smal @ running  ec2-1 Instance Management 04-27 13:18 PL:
O 0@ i1027c9a  amicT4falae  mlsmall | @ moning  ec2l oo 04-27 10:36 PI
IMAGES | ———
+ AMIs H [ i-159de17e  ami-69¢3200 m1.smal | @ running ec2-7{  GetSystem Log 04-26 16:06 Pl
» Bundle Tasks [0 idids6a3bbe  ami-B6db3%ef m1.large @ running | ec2-T:

04-15 01:26 PI

Bundle Instance (S3 AMI)

2 P "
ELASTIC BLOCK STORE O | [ i-9147d7fa | ami45c22e2c | mi.small 'mslogged Get Windows Password 04-07 10:13 Pl '~
Launch More Like This

> Volumes 1 EC2 Instance selected )
Instance Lifecycle =
> Snapshots @ EC2 Instance: i-159del7e =
Terminate
NETWORKING & SECURITY Description || Monitoring Reboot
> Elastic IPs Stop
AMI ID: ami-69c32f00 start east-1c
> Security Groups =
. Security Groups: default small
» Key Pairs Cloudwatch Monitoring =
> Load Balancers < I Enable Cloudwatch 5
Disable CloudWatch
@© 2008 - 2008, Amazon Web Services LLC or its affiliates. All right reserved. Feedback Support Pri n ama: compary
https:/fconsole.aws.amazon.comfec2/home# & |

7% -] [~ ceose

Create Image caneal x|

Instance Id:  i-159del7e

Image Name*:  [Base Image J

Image Description:  [Base imagd |

The instance you're using as a template for a new image has the following
volumes:

« /dev/sdal, vol-1354e77a (30 GiB), will delete on termination
« xvdf, vol-8b52e1e2 (20 GiB), will not delete on termination

Total size of EBS volumes: 50 GiB.

When you create an EBS image an EBS snapshot will also be created for each
of the above volumes.

“Required Fisld
Create This Image | or Cancel d
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AWS Managemen! il i create Image:

6 - X D _mm‘fl home #c=EC: . . .
[ 5 aves renspcment consle = B To view the image creation

e e e e e T i e Welcome, Citeix Test | Seftings | Sign 0ut process, select AMIs from the
EC2 Console.

Amazon Elastic Amazon
MapReduce CloudFront

Amazon EC2 ‘

Region: B S cast v & (4 Register New AMI [T showtiide || & Refresh || @ Help
iewing: | Owned By Me || All Platforms { € 1tozzofzzAMIs P

 £c2 Dashboard Viewing: y I I | € ¢ 1w22a = > 3l
AMI ID Visibility Status Name 4+ Description Image Size

INSTANCES =
@ ami-4743ad2e = Private ) pending Base Image Base Image =

> Instances =

» Spot Requests O @l amidcce23bs | Private @ available Ctrix Support W2KE 80 GiB |

O | @) ami-e3d7388a | Private @ available wanscaler-vpe-proto

IMAGES

- | O  @amif339d6% | Public @ available XenApp5.0_32bit_\" XenApp AMI 30 GiB

> Bundle Tasks ] aj ami-06d8356f Public @ available KenApp5.0_AGSEC XenApp/Access Ga 30 GiB

LAsTie BLock SroRE [0 @l amif322cPa | Public @ available XenApp5 0_AGSEC XenApp 50 / Acces 30 GiB -

» Volumes 0 EC2 Amazon Machine Images selected

> Snapshots Select an image above

NETWORKING & SECURITY

> Elastic IPs

> Security Groups

> Key Pairs

> Load Balancers

@ 2008 - 2008, Amazon Web Services LLC or its affiliates. Al right reserved. Feedback Support Privacy Policy | Terms of Use An amazoncom. compary

Done a8
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Launch Instance:

From the Amazon EC2
Dashboard, select AMIs.

Find the image that we created
as Base Image.

Launch an instance of this
image.

Follow the remaining prompts.

Elastic IP:

From the Amazon EC2
Dashboard, select Elastic IPs.

Allocate a new IP Address and
assign it to the instance.

CITRIX

Domain Controller

Domain Controller, DNS Server

Create a Domain Controller, DNS Server for the environment.

anagement Console - Mozilla Firefox

) home #c=EC 77 -] [$;- cooge

Wl aws.amazon.com AWS | Products | Developers | Community | Support | Account Welcome, Citrix Test | Settings | Sign Out
Amazon Elastic Amazon
Amazon EC2 || CloudFront

Region: B Sgast v || || @BLlaunch || <dSpotRequest || [} Register New AMI || [L Deregisier || (¥ Permissions

~|[ Al Platiorms || |

[T3 showide || & Refresh

[¢ € 1w2zofzzams > 3

 £C2 Dashboard Viewing: | Owned By Me

AMI ID Visibility Status Name Description Image Size
INSTANCES ; ]
et @) ami-4743ad2e  Private @ available Base | 50 GiB al
> Instances =
 spot O  @lami-dcce23bs  Private @ available Ctrix SU" R quast Spot Tnetamee | 80GB j
O @ ami-e3d7388a  Private @ available wanscg Edit Permissions
IMAGES - De-register AMI e —
L Ame . O @lemp3uds9a  Public @ available XenApp 30 GiB
> Bundle Tasks [} @ ami-06d8356f  Public @ available XenApp5.0_AGSEC XenApp/Access Ga 30 GiB

O @lamif322c8a  Public @ available XenAppS 0_AGSEC XenApp 5.0/ Acces 30 GiB

ELASTIC BLOCK STORE =
> Volumes 1 EC2 Amazon Machine Image selected ﬁ
> Snapshots @ EC2 Amazon Machine Image: ami-4743ad2e r
NETWORKING & SECURITY AMI ID: ami-4743ad2e
> Elastic IPs Name: Base Image
> Security G
urity Groups Description: Base Image
> Key Pairs
+ Load Balancers Source: 519701941432/Base Image @
® 2008 - 2008, Amazon Web Services LLC or its affiliates. All right reserved. Feedback Support Privacy Policy Terms of Use An amazoncom. compan
hitos:/fconsole.ans. amazon. comjecz/nome I |

Associate Address Cancel [x/

Address: 184.73.213.80

Instance ID: [{G7677564 v

[&]..
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ommand Prompt

C:\>mstsc sconsole

-
'ﬁ Remote Desktop Connection

Computer:

|zer name:

Remote Desktop
Connection

1184.73.212.80

You will be asked for credentials when you connect.

IP-0AD305AB  Administrator

[ Connect |[ Cancel ][

Help ] [ Ciptions == ]

ﬁ 184.73.213.80 - Remote Desktop

EEX

~ Control Panel = System

Task
@ Devic
@

@ Aden

Computer descrption

Full computer name:

Workgroup:

)E
.

Computer Name | Hardware | Advanced | Remote |

Windows uses the following information to idertfy your computer
on the network

ights reserved.

Computer Name /Domain Changes
For example Mad / = E

" Accounting
ip-0AD309
WORKGRC

To rename this computer or change its
workgroup. click Change

See also

Windows Update

{15 | 5

| 1 system

You can change the name and the membership of this
computer. Changes might affect access to network resources.
More infomation

Computer name

[odl

Full computer name:

Member of
€ Domain:

" Workgroup:

W
coes

L66GHz 2,75 GHz

(@IChange settings

wlor .
genuine’ .
Microsoft®
software

Learn more orline.

|[ 5 System Properties

(=&

Connect:

Connect to the instances IP
Address you just assigned, by
running Remote Desktop from
your local computer.

From a command prompt:

mstsc /console

Domain Controller:

Navigate to Computer ->
Properties and change the
computer name to DC for
Domain Controller.

Reboot and Reconnect.

30
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Domain Controller:

Navigate to Control Panel ->
Programs and Features -> Turn
Windows features on or off.

Add Roles.

Add Active Directory Domain
Services.

Domain Controller:

After Domain Services is
installed, run dcpromo.exe.

%% 184.73.213.]

80 - Remote Desktop.

Server Manager

Fle Acton View Help

CiTRIX

Roles

5 storage

Server Manager (D! PYFTRINE

i Features
Diagnostics
'} Configuration

izard

Before You Begin
Active Directory Domain Services.
Confirmation
Progress
Resuilts
STy

Select one or more roles to install on this server.
Roles:

Description:

[ Active Directory Certificate Services

ry Domair

[ Active Directory Federation Services

[ Active Directory Lightweight Directory Services

[] Active Directory Rights Management Services
Application Server (Installed)

[ DHCP Server

] NS Server

[] Fax Server

[] File Services

[ Network Palicy and Access Services

] Print Services
Terminal Services (Installed)

[ uUDDI Services

Web Server (IIS) (Installed)

[] Windows Deployment Services

[] Windows Server Update Services

More about server roles

Active Directory Domain Services (AD
DS)stores information about objects
on the netwark and makes this
information available to users and
network administrators. AD DS uses
domain controllers to give network
users access to permitted resources
anywhere on the network thraugh a
single logon process.

<previous |[ mext> | el Cancel

g e

Message Queuing Server

£% Refresh disabled whie wizard in use

&= =ld e —

ﬁ Select Server Roles

] |

| [ Programs and Features

| T Server Manager

4+ 184.73.213.80 - Remote Desktop

E_ server Manager

File  Action  View

Help

Server Manager {Di
3 Roles

[ i Features
Jm Diagnostics
5} Configuration

@ 23 storage

Add Roles Wizard

o M Eall?] I —

;

ﬁ Installation Results

Before You Begin
Server Rales
Active Directory Domain Services

Confirmation

Progress

The following roles, role services, or features were installed successfully:

/+. Lwarning, 1informational messages below

i Windows automatic updating is not enabled. To install the latest updates, use Windows Update in

"% Control Panel to chedk for updates.
(4] Active Directory Domain Services

The following role services were installed:

Active Directory Domain Controller

(i) Use the Active Directory Domain Services Installation Wizard (depromo.exe) to make the server a

fully functional domain controller.

Close this wizard and launch the Active Directory Domain Services Installation Wizard (depromo.exe).

TTESSAE QUETTy

Print, e-mail, or save the instalation report

< Previous

@ Installation succeeded

et | [ close Cancel

Message Queting Services

4 Refresh disabled while wizard in use

Lrstart| | 2 mm

| i Programs and Features

|52 server Manager

[8G
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P——— |

Name the Forest Root Domain E ‘
The frst domain in the forest s the forest roct domain. ks name is also the rame of |
the forest L
Type the fully qualfied domain name (FRDN) of the nesw forest root domain.
rm top management tasks, and add or remove server roles and features.
FQDN cf the forest root domain: _ R
citridabs.com| [ Configure TEESC
Example: corp.cortoso.com
ftrators
Roles Summary Help
3 GotoRales
S AddRoles
i Remove Roles
<Back Next > Cancel :
Features Summary Help

(%) Features: 5 of 35 installed

NET Framework 3.0 Features
NET Framework 3.0
XP5 Viewer
WCF Activation
HTTP Activation
Non-HTTP Activation
Message Queving
Message Queving Services

<% Refresh disabled whie wizard in use

& Add Features
5 Remove Features

| [ Programs and Features | =, Server Manager

| [} Active Directory Dom...

Additional Domain Controller Options:

P——— |

*
Select addtional options for this domain controller.
1m top management tasks, and add or remove server roles and features.
[¥ DNS server
I¥ | Global catalog - -
[ Configure IEESC
I=| Fiead oy domain contialer [FODE]
Additional information:
The first domain cortroller in a forest must be a global catalog server and =]
it be an RODC. frraters
We recommend that you install the DNS Server service on the first domain
cortroler. :
Roles Summary Help
g 5 GotoRoles
S AddRoles
More about addtionsl domain controlier options 2 Remove Roles
<Back Next > Cancel -
Features Summary Help

(%) Features: 5 of 35 installed

NET Framework 3.0 Features
NET Framework 3.0
XP5 Viewer
WCF Activation
HTTP Activation
Non-HTTP Activation
Message Queving
Message Queving Services

<% Refresh disabled whie wizard in use

& Add Features
5 Remove Features

Lrstant| | 2, M0

| [ Programs and Features | =, Server Manager

| [} Active Directory Dom...

[

Domain Controller:
Ignore the warning messages.

We are creating a domain in a
new forest.

For this POC, the domain is
citrixlabs.com.

Domain Controller:
Install DNS on this machine.

Note: Respond “Yes” to the
question if you will use a
dynamic IP Address - which is
assigned by Amazon. In fact,
you will be using an Elastic IP
address, or Static IP address for
this server.

Respond “Yes” to continue if a
delegation cannot be found.
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Domain Controller:

Review and continue.

Domain Controller:
DNS and ADS is installed.

CiTRIX

#3 184.73.213.80 - Remote Desktop.

5

Review your selections
rfigure this server as the first Active Directory domain cortrollerin a new forest._« m top e T R R e (i

——— |

& new domain niame is cilridabs.com. This is also the name of the new forest — -
Configure [E ESC

e NetBIOS name of the domain is CITRIXLABS
Forest Functional Level: Windows 2000
Domain Functional Level: Windows 2000 Native rators

e: Defautt-First-Gte-Name

ditional Options, P
To change an option, clck Back. To begin the operation, click Next = oo
5" Go toRoles
These seftings can be exported to an answerfie for use with — s add Roles
cther Unaitended operatons. ST B Remove Roles
More about Lsing an answer fle =

< Back Next > Cancel

Features Summary Help

(~) Features: 5of 35 installed (& Add Features

& Remove Features
NET Framework 3.0 Features

-NET Framework 3.0
XPS Viewer
WCF Activation
HTTP Activation
MNon-HTTP Activation
Message Queuing

Message Queving Services

44 Refresh disabled while nizerd in use

Lstart| | 3o M | (il Programs and Features | i Server Manager |[& Active Directory Dom... =T

%3 184.73.213.80 - Remote Desktop

g s Bl
i
g Review your selections:
E figure this server as the first Adtive Drectory domain cortroller n @ new forest. m top tasks, and add or remove server roles and features.
d & new domain name is ctredabs.com. This is also the name of the new forest - - - _I
[ Configure EEESC
e NetBIOS niame of the domain is CITRIXLABS
Forest Functionial Level: Windows 2000
Active Directory Domain Services Installation Wizard
Domain Functional Level: Windows 2000 Native
The wizard is corfiguring Active Directory Domain Services. This process can take.
o: Defaut-First-Ste-Name from a few minutes to several hours, depending on your environment and the options
) that you selected
dtional Cplons Roles Summary Help
To change an option. ciick Back. Ta begin the o =
1= =N opi begnthe o 7 5> 6o o Roles
These settings can be exported to an answerfile S Add Roles
oiher unattended operations. =5
More about Lsing an answer e B Remove Roles
Waiting for DNS installation to finish
“ Cancel
— Features Summary Help
I™ Reboot on completion
Feature. 5L Add Features
(& Remove Features
NET Framework 3.0 Features
.NET Framework 3.0
XPS Viewer
WICF Activation
HTTP Activation
Non HTTP Activation
Message Queuing
Message Quewing Services Ll
4 Refresh disabled while wizard in use
Lrstart| | 2 mm | i Programs and Features | =L, Server Manager Active Directory Dom... s
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#3 184.73.213.80 - Remote Desktop

Domain Controller:

Completing the Active Directory
5 <

When finished, reboot.
Do S o ——

Aciive Directory Domain Services is now installed on this < |
computer for the domain cirdabs.com.

bt

m top management tasks, and add or remove server roles and features.

pppp——= [N}

This Active Directory domain cortrolleris assignzd to the
e Default-First-Site-Name. You can manage sites with - - - ;I

the Active Directory Stes and Services administrative [ Configure IEESC

ool

=l ktrators

To close this wizard, click Finish

Roles Summary Help

" Go to Roles
Add Roles
5 Remove Roles

< Back I Finish I Cange

Features Summary Help

~) Features: 5of 35 installed (4 Add Features

{5 Remove Features
.NET Framework 3.0 Features
NET Framework 3.0
XPS Viewer
WCF Activation
HTTP Activation
Non-HTTP Activation
Message Queuing
Message Queuing Services =l
473 Refresh disabled while wizard in use

{rstan] | 3, | [ Programs and Features |k Server Manager ||/ Active Directory Dom..

#3 184.73.213.80 - Remote Desktop

Domain Controller:

To login, you need to use the
domain credentials.

ex: citrixlabs\administrator

citrilabshadministrator

Windows Server 2008
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Launch Instance:

From the Amazon EC2
Dashboard, select AMIs.

Find the image that we created
as XenApp Base Image.

Launch an instance of this
image.

Follow the remaining prompts.

Elastic IP:

From the Amazon EC2
Dashboard, select Elastic IPs.

Allocate a new IP Address and
assign it to the instance.

CITRIX

XenApp Install

XenApp License Server

Install the XenApp License server.

) home #c=EC. 77 -] [$;- cooge
Wl aws.amazon.com AWS | Products | Developers | Community | Support | Account Welcome, Citrix Test | Settings | Sign Out
Amazon Elastic Amazon

Amazon EC2 || H CloudFront |
Amazon Machine Images

Region: i Launch || 4 Spot Request | [ Register New AMI || [ De-register || (¥ Permissions [T3 showide || & Refresh

» £C2 Dashboard Viewing:| Owned By Me ~|[ Al Platiorms || | 1€ € 1tazzof2zams 3 3]

AMI ID Visibility Status Name Description Image Size
INSTANCES ; ]
Inst @) ami-4743ad2e  Private & available Base Image Base Image 50 GiB L
> Instances =
. spot O @lamidoce2dbs = Private @ available Ctrix Support W2, Launeh instance s 3
- Request Spot Instance

- O @ ami-e3d7388a  Private @ available wanscalerpe-pri pop oo

- . 0O  @)amif330d69a  Public @ available XenApps.0_32bit| De-register AMI B

> Bundle Tasks [} @ ami-06d8356f  Public @ available XenApp5.0_AGSEC XenApp/Access Ga 30 GiB

CLASTIC Bk SToRE O @lamif322c8a  Public @ available XenApps 0_AGSEC XenApp 5.0/ Acces 30 GiB -

> volumes 1 EC2 Amazon Machine Image selected |

> Snapshots @ EC2 Amazon Machine Image: ami-4743ad2e 4
NETWORKING & SECURITY | | AMI 1D: ami-4743ad2e

* ElasticIPs Name: Base Image

» Security G

urity Groups Description: Base Image
> Key Pairs
+ Load Balancers Source: 519701941432/Base Image @l
® 2008 - 2008, Amazon Web Services LLC or its affilistes. Al right reserved. Fesdback Support Privacy Folicy | TermsofUse AN amazoncom. company
hitps: fconsale. aws, amazan, comjec2lhome I |

Associate Address Cancel [x/

Address: 184.73.212.58

Instance ID: :j2fhdc5dd v |

[&]..
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Command Prompt

C:\>mstsc sconsole

-
'ﬁ Remote Desktop Connection

Remote Desktop
Connection

Computer: 1847321258

Username: CTXSLICT'Administrator

You will be asked for credentials when you connect.

Connect H Cancel ][ Help

] [ Ciptions == ]

#9 ec2-184-73-212-58.compute-1.amazonaws.com - Remote Desktop

iy

- & [sea0

Organize v {5 Views ~ (% System properties [ Uninstallor change aprogram . Map network drive Open Control Panel

Name || Type « | =] Total size || Free Space 1=l

 ecydle B Favorite Links
Rz Hard Disk Drives (2)

[F| bocuments

B Fictures &, Local Disk () Local Disk 2.968 0368

B music (aNew Volume (D:) Local Disk 19.9G8 14,0 GB

|4 Recently Changed Other (10)
[ searches

G¥ConSICloaigeld2  System Folder
Public

G#DonSICLaaigeld2  System Folder
GFEonSiCloraigell2  System Folder
GSFonSICloraigell2  System Folder
S#G on 51CLaraigelo2 System Folder
G¥HonSICLaaigeld2  System Folder
G9Won SICLaraigell2  System Folder
G#¥onSiCloraigell2  System Folder
S9YonSCloraigell2  System Folder
S#7 on SICLeraigeln2 System Folder

Folders ~

IP-DAD309AB Workaroup: WORKGROUP

L«& Processor; Dual-Core AMD Opteron(tm) Processor 2218 HE
Memory: 166 GB

|f:% computer

{1 | 5

[ =g,

Connect:

Connect to the instances IP
Address you just assigned, by
running Remote Desktop from
your local computer.

From a command prompt:

mstsc /console

Connect:

Once logged into the instance,
open Computer, you should see
the D: drive still connected. If
not, attach it to the instance.
You can find it under volumes in
the EC2 Dashboard.



License Ser\ler: 3 184.73.212.58 - Remato Deskiop

Navigate to Control Panel ->
Network and Sharing Center.

v & [se=n

Neme -+ | -| Category | -]
Control Panel Home ﬁ,:h m
T

N LV R

Add Hardware Administrative  AutoPlay Bluetooth Color W Default
ogls Devices  Management Programs

2@ F

Device Easeof  Folder Options  Fonts Indexing Install
Manager  Access Center Options  Application ...

¢ < . & =

LE)

iSCSLInitiator  Keyboard N Offiine Files  Personaliza...  Phone and
Modem ...

Pl M

Power Options  Printers problem  Programsand Regionaland  Sound
Reportsa...  Featres  language ...

A= 0 # 9

Taskbarand  Textto  User Accounts  Windows Windows Windows
Start Menu Speech CardSpace Firewall Update

License Ser\ler: £2104.73.212.50 - Remate Desktop

In the IPv4 Properties, use the
following DNS server address:

L)
184.73.213.80. o T — ®
View comp = W Local Area Connection 2 Properties View fullmap
Note: This address will Comecttc Gomnecsn —————— Netwakna | .
. Setwpac IPy4 Connectivity: | a
be d |ﬁ:erent fOI’ yOU r Manage ne [Pv6 Cannectivty: et o Internet Protocol Version 4 (TCP/IPv4) Properties K

Media State: £ RedHat PV

implementation. It is the Elastic S oaton enerel | mate confuren |

. S ¥ 1P setts ed automatically i twork ts
IP Address you assigned to — T o rvae, o reed o fou seono s

T Ciontfor |, for the appropriate IF settings.

your Domain Controller through  [8lGos pack

= File and Pr % Obtain an [P address automatically
the Amazon Console.  — e | s o P o
& LinkeLayer IP address:
This will allow the License " || — |
« . . . N Default gateway:
Server to join the domain e .
s ¢ properties | @Disab - Obtain DNS server address automatically
citrixlabs.com. e | [ | - r—c—————

wide area nstwor
e e | Preferred DNS server: 184 . 73 .213. 80|

Alternate DNS server:

Seealso
Internet Options

Windows Firewall

Crstart| | 3, m | £ Network and sharing Ce...

| 1 Local Area Connectio... s
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#3 ec-184-73-212-58.compute-1.amazonaws. com - Remote Desktop EEX Lice nse Server:

Because the License is tied
to hostname, you will want to
set the Computer Name, and
reboot.

Navigate to Computer -> Right-
Click -> Properties.

-, Server Manager !f 7
i Command Prompt

Administrator

“'! Windows Update
=
fe Internet Explorer

.:] Notepad

Documents.

Open
Explore

Netwark
Manage

@ SQL Server Configuration Manager |
Gl Map Netwark Drive...

|® Ease of Access Center 5 o~ Disconnect Network Drive..
& 8
- «» Show on Desktop
EEmiEs=tls Help and Support Rename
Run..
Windows Security

» All Programs

[start search B o a |[»
st | G m | ). ticensing |

£%184.73.212.58 - RemoteDesktop [x License Server:

yste Change Settings for Hostname.

st
OO [+ ControlPanel ~ System = [&@[scorn 2]

}, In our example, we set the
mputer
g Comdortiane | adars | advar | Rt | ’ License Server hostname to

.JL-Q. ‘::rg::sm&\efu\lmng information to identify your computer CTXSI iC_1 .

n. All rights reserved.

Computer description: |

F’:ﬂ‘zsfw;’“ Note: Hostname is tied to the

Ful computername:  ip-0AD30SAB You can change the name and the membership of this CItrlX License-

computer. Changes might affect access to network resources.
Werkgroup: 'WORKGROUP Mors infoimation

Ta rename this computer ar change s domain or Gre 2,79 Griz Also, you will need to jOin the

workgroup, dlick Change. Computer name:

et domain. In this example, it is
o ot e —— citrixlabs.com

[@/Change settings

Verberct Reboot and Reconnect using
= Remote Desktop.

[etrdabs conl
£ W :
oK ko adcfor, )
= [WORKGROUP genuine -
Microsoft”
See also software:
Windows Update = Learn more online...

A"Sﬁlftl |am | 12 system | 1 System Properties =ik




License ser\ler: A% 184.73.212.58 - Remote Desktop

You will need to login with
domain credentials. For
example:

citrixlabs\administrator

" Windows Server 2006
Datacenter

Li cense se rver: #% ec2-184-73-212-58.compute-1.amazonaws.com - Remate Desktop

NaV|gate to the D dere, C}v [~ Computer - New Volume () - XenAgpSep3 - XAS_FPI_PLT_MLL - Licensing - B

Organize v = views v jSlmswl -

Citrix Licensing folder. "

i i . F| pocuments
Run the CTX_Licensing.msi £ o
install. 5 recenty rarged
5 searches

. Public

2B

~| size

~| Tags
17,906 KB

Citrix

Insta...

Folders. ~

CTX_Licensing Date mocified: 3/11/2010 8:26 AM
Tl Windows Installr Package Size: 17.4MB
I 2 Date created: 3/11/2010 8:26 AM

Lrstant| | 3 W || . Licensing iy
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L]
CiTRIX

License Server Configuration

Specify the numbers for the following ports:
License Server Port (default 27000);
Vendor Daemon Port (default 7279):

Management Conscle Web Port (default 8082):

Set a password for the License Administration Console:

Username: admin

Password:

Confirm Password:

%3 184.73.212.58 - Remote Desktop.

| -] Date modified |- Type | -| size: | -] Tags.

Favarite Links
[ p—— 215110 0 81 AR Wi Tl 7 A VR it Tonie

[lER:Y *E internet Information Services (II5) Manager [_ O[]
B @g) [_ﬂj»crxsucl»smesb |@ < @
Bae
5 r Fle Vew Heb
¢ - o,
2= Ites
i T 7
-G Start Page
95 CTXSLIC (CITRIML
~|5} Application Pools Name
45, FTP Sites
-8 Sites
& Default Web Site Edit Site
Bindings...
[=] Basic settings...
2 Explore
Edit Permissions.
XK remove
Rename

(i) This site has multiple bindings

Filter: ~ (fico - show Al | Groupby: o Grouping

& Add Web Site....
Set Web Site Defaults...

View Applications
View Virtual Directories
Manage Web Site
> Restart
b stat
@ stop
Browse Web Site
Browse *:80 (http)
Advanced Settings...

|
Features View [/ Content View

{8 Citrix Licensing Setup o = a0

:‘ShrtH hHhom | . ticensing

License Server:

Configure License Server.

License Server:

By default, Amazon AMI’s have
IIS stopped. You must start it
manually, and set the service
to start automatically if you
want the configuration GUI for
License Server to work.
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License Server:

D ense Ad 0 onsole do e plore M=l E3
Launch the License 6@4'I@Iw‘m:r.‘lnm\hnstzsﬂs235‘.‘5‘Em\nfu"‘Eudm=C]TRIxM\(EnsETah=&sEIE[tEd= =1 8] ] [ tve searcn e
ini i 7y Favorites | {3 @ suggested Sites + ] Web Sice Gallery +
Administration Console. :
{2 Citrix License Administration Console | | - - ) f=n - Page - Safety~ Tools - @~

Start -> All Programs -> Citrix - _ — 0 ©
-> Management Consoles ->
License Administration Console.

Log into the License ||[| System Information
. System Release Version: 1161 build 10007
Administrator Console, under Inomatlon License Server Manager Port Number in Use: 700
H] . Display: CTXSlicl
Administration. i e
Host Domain Name: CTXShcl citrixlabs.com
IPv4 Address: 10.208.119.226
IPv6 Address: Te80:0:0:0:b9d8: bb0b:17f2:d5b9
Ethernet Address: 123139067014
Volume Serial Number: 6930977 o
Local Stop Server Allowed: No
Remote Stop Server Allowed: No
License Reclaim Allowed: No
;
4 B
Done [T [ [ [ [ [ ocalintranet | protected Mode: Off [%a~ [®w0% -

Costart| | G M @ | | Licensing |[@ Gitrix ticense Adminis... e

License server: ﬁ'ecZ-134-73-212-SE.compute-1.an1azonaws.com - Remote Desktop

) Girix Lcense Adminitration Corsole - Mozilafirefox _____________________________________________________EEE
Select Vendor Daemon @B c « ek = m—n FEl: B 5
Configuration -> Import P r————— E
License. L _ @ © |

Install the License file you Dutboard  Admetcion
obtained from MyCitrix.com. m

Vendor Daemon Configuration

-
Information *
‘ Import License

5z [ Status Version Port
Configuration =]

~

Configuration

Server

Configuration
CITREX RUNNING 16 7279 Administer Delete

4

Vendor Daemon
Configuration

If'snart| |Gm &@ | | lcesng | @ ntip:/ocalnost:a082 - .. |[@ Citrix License Adminis... [T
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#3 ec2-184-73-212-58.compute-1.amazonaws.com - Remote Desktop

stration Console - Mozilla Firefox

ab=8selected=

System
Information

Configuration

A

Alert
Configuration

&

Configuration

Vendor Daemon
Configuration

User Name: admin

Vendor Daemon Configuration

Import License

Name a Status

Port

CITRIX RUNNING 116 7278 Administer Delete

Administration
—

.

[o] cm @] [ . [ e e

2

#3 ec2-184-73-212-58.compute-1.amazonaws.com - Remote Desktop

) Gitrix License Ad

stration Console - lla Firefox

7% | [F-Tecoge

y:
Information

L

Configuration
A
Jes
Configuration

Server

Configuration

Vendor Daemon
Configuration

User Name: admin

Dashboard

Vendor Daemon: CITRIX

Vendor Daemon Port in Use: 7279

Vendor Daemon Actions:
[ sop | Rereas
Report Log Name: | Rotate Report Logs

General Configuration

* License File or Directory:

[Ci\Program Files\Gityix\ Licensing\MyFilss

Vendor Daemon Location:

* Vendor Daemon Port:
€ Use default port

& Use this port [7279

@ ©

Administration
—

I."shrt” Y

6@ ) v |& .. [ e iccnse Admiis.

License Server:

Select the Administer link.

License Server:

Reread License Files.
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Launch Instance:

From the Amazon EC2
Dashboard, select AMls.

Find the image that we created
as XenApp Base Image.

Launch an instance of this
image.

Follow the remaining prompts.

Elastic IP:

From the Amazon EC2
Dashboard, select Elastic IPs.

Allocate a new IP Address and
assign it to the instance.

XenApp Web Interface

Install the XenApp Web Interface

a Firefox

CITRIX

v '| @' Google

Wil aws.amazon.com AWS | Products | Develoj

pers | Community | Support | Account Welcome, Citrix Test  Settings  Sign Out
Amazon Elastic Amazon

SmazonEC2 || H CloudFront |

Region: i Launch || . Spot Request || [ Register New AMI || [ De-register || Ty Permissions [3 showmide | & Refresh

. Viewing:| Owned By Me || All Platforms || ] 1€ € 1tozzofozams 3 3

AMI ID Visibility Status Name 4 Description Image Size
INSTANCES ; a
et @am\-ﬂﬂaﬂe Private D available Base Image B L
> Instances i]
» Spot O @ amidcce23bs  Private @ available Ctrix Support W2) Aoquost Spt Tnetance
O  @lami-e3d7388a  Private @ available wanscalervpe-pro Edit Permissions

IMAGES N

L Amre . O @ amif139d69a  Public @ available XenApps.0_32bt | DE-Tedistar AMI B

. Bundle Tasks O @)ami-06d8366f  Public @ available XenApp5.0_AGSEC XenApplAccess Ga 30 GiB

ELASTIC BLOCK STORE O ami-f322cf9a Public [*] ava\\a!)'\? XenApp5.0 AGSEC XenApp 5.0/ Acces 30 GiB .vj
> Volumes 1 EC2 Amazon Machine Image selected L)
> Snapshots @ EC2 Amazon Machine Image: ami-4743ad2e ;
NETWORKING & SECURITY —| | AMI ID: ami-4743ad2e

> Elastic IPs Name: Base Image

s N

Security Groups Description: Base Image
> Key Pairs
, Load Balancers Source: 519701941432/Base Image gl

© 2008 - 2009, Amazon Web Services LLC or its affiliates.

Allright reserved. | Feedback | Support | Privacy Policy

Terms of Use

An amazoncom. compary

https:/fconsole.aws. amazon, comfec2/home

I |

home #c=EC.

Google

Associate Address

€ancel [/

Address: 184.73.197.3

Instance ID: :i-fd463896 v |

[ @] .
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Command Prompt

C:\>mstsc sconsole

-
ﬁ Remote Desktop Connection

Remote Desktop
Connection

Computer; 24731573

Username:  |P-DAFDS1AT Administrator

You will be asked for credentials when you connect.

Connect H Cancel ][ Help

] [ Cptions == ]

|
o
x

(;C)v 5~ Control Panel ~ Network and Sharing Center - @

Tasks Hetwork and Sharing Center

View computers and devices

42605 Packet ¢

Publc folder sharing BlFie and Prie (5 Obtain an 1P address automaticall
? I = Intamet Proto £ Use the following IP

View full map
Connect to 2 network
Setup a connection or network i L =
P . T
Manage network connections 8 Local Area Connection 2 Status termet
Diagnose and repair
General |
I Local Area Connection 2 Properties
7 Metwork (b | COMEOT Ty g |
— [Pv4 Connectiv
Access .
[Pv6 Connectiy  Connect using
Connecton Media State: P TEPIITe] Interet Protocol Version 4 (TCP/IPv4) Properties [21]
Bl General | alternate Configuration |
2 Sharing and D Speed:
- This connection usest YU €3N get TP settings assigned automaticaly if your network supports
Network discovery Detais... T this capabilty, Othernise, you need to ask your network administrator
S & Clier for Micr for the appropriate [P settings
File sharing

o5

Printer sharing -4 Intemet Proto

Password protected <& Link-Layer To

Show me all the shar

& Link-Layer To 1P adldress: -
Subnet mask: — |
Bytes:
Show me al the fles Default gateiay; -
Irstal]

Opertes |

Transmission Contro
ide area network £

" Obtain DNS server address automatically
£+ Use the following DIS server addresses:

across diverse inter Preferred DNS server: 184. 73 . 213 . 80|
Alternate DNS server: .

See also

Intemet Options

Advanced...

Windows Firewall

Costart| | Z, B | & Network and sharing Ce... [[ 1] Local Area Connectio...

[ &%

Connect:

Connect to the instances IP
Address you just assigned, by
running Remote Desktop from
your local computer.

From a command prompt:

mstsc /console

DNS Settings:

Navigate to Control Panel ->
Network and Sharing Center.

In the IPv4 Properties, use the
following DNS server address:

184.73.213.80.

Note: This address will

be different for your
implementation. It is the Elastic
IP Address you assigned to
your Domain Controller through
the Amazon Console.
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Web Interface:

As a matter of convenience it
is recommended to change
the hostname to something
meaningful.

Navigate to Computer -> Right-
Click -> Properties.

Web Interface:

Change Settings for Hostname
and join the domain.

In this example:
Computer Name: WI
Domain: citrixlabs.com

Reboot and Reconnect using
Remote Desktop.

#%ec2 184-73-212- 58.compute-1.amazonaws.com - Remote Desktop

i% Server Manager

A Command Prompt

Administrator

# l Windows Update
B Documents

@ Internet Explorer
d
o ] Notepad
Netwark i
M
@ SQL Server Configuration Manager ==
- Control Panel Map Netwark Drive...
®| E—— R e oot Disconnect Network Drive...
R s
= + Show on Deskiop
EC2ConfigService Settings. Help and Support Rename
Run...
Windows Security

» AlPrograms.

B o | a |

— |

[stert search

ostart | 3, B |

CiTRIX

#3 184.73.197.3 - Remote Desktop

)

OO [F2"~ Gontrol Panel + System

Tash

[System Properties
r
I Devic

Computer Name | Hardhware | Advanced | Remete |

Windows uses the following information to identify your computer
on the network.

@ Remc !’_y’

@ Adva ights reserved.

Computer Name/Domain Changes [ ]

You can change the name and the membership o this
computer. Changes might affect access to network resources
More iformation

Computer description: |

For example: "lIS
“Accounting Ser

ipDAD309AB
WORKGROUP

Full computer name:

Workgroup

Ta rename this computer or changs fs dom
s R CI%TM“ =2

Full computer name:
wi

Member of
= Domain
Iutmdahs com]

£ Workgroup:

W
o

See also
Windows Update

Hz 2.76GHz

(fChange settings

ackfor . -
genuine -
Microsoft®
software

Learn more online...

Crstart]| | 3, M | 74 system |[7% System Properties

e
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#% 184.73.197.3 - Remote Desktop

B Web Interface
S S\
QL/V [ 1~ Computer ~ New Volume (D:) ~ XenAppSsp3 ~ XAS_FP3_PLT_MLL ~ Web Interface v 883 [search 2]
Organize v 15 Views ~ @
Eavorite Links Name = | +| Date modified [ -| Type || size | -] Taes |1
" Weblnterface 4/26/20109:12PM Appiication 16,038 KB
IE Documents || weblnterface jar 4/26/2010 9:12PM  JAR File 18,338 KB
[E) Pictures
& Music
(5 Recently Changed
I searches
| Public
Folders A~
] 2 items
Costart| | 3, M || Web Interface s

#3 184.73.197.3 - Remote Desktop

v

i Web Interface Setup

Updating System

The features you selected are being installed

Validating install

|

Cancel

Lostart| | 3 M E | xenappprep utiity

| & 29% of xas01_wsos E... [ 751 web Interface Setup

[

Web Interface:

Navigate to the XenApp install
folder on drive D:.

Open the Web Interface folder,
and run the Weblnterface.exe
installer.

Note: Microsoft Visual J# 2.0
can be downloaded from
Microsoft’s website.

Web Interface:
Install Web Interface.

Note: If you receive an error
message that Web Interface
cannot complete installation
due to the fact that <domain>\
None is an invalid user or group,
Remove the machine from the
domain, install Web Interface,
and the join the domain again.
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Web Interface:

When the Web Interface
Management console appears,
select Create Site.

[IS: Default Web Site
Path: /Citrix/XenApp/
Name: XenApp

Set as default page for IIS

Web Interface:

Authenticate at Web Interface.

#3 184.73.197.3 - Remote Desktop
¥ Citrix Web Interface Management
Fie Acton View Help

NGl 7] |

[ citrx Wb Interface

- XenApp Web Sites Actom
enApp Web Sites. » web R
XenApp Services Sites Site name [ Ste URL [
Create Site
0O " View »
CiTRIX B reret
Spegify IIS Lacation H rep 4

Specify the IS location in which the site is hosted. This determines the URL for users to access the site.
IS site:  [Defaut Web Ste =

[#Cirix/XenApn/

S Name: [XenAop
[V Set as the defak page forthe 115 ste

Next > Cancel
Create a new XenApp Web site. Users access resources through a Web browser [ |
Costart| | G B @ | | XenagpprepUtity | Web Interface | & 33% of xas01_wso8 E... [[@ Citrix Web Interface .. 16

#3 184.73.197.3 - Remote Desktop

¥ Citrix Web Interface Management

Fie Acton View Help

2|2 R |

[ Citric Web Interface

- XenApp Web Sites Actons
‘enApp Web Sites T .
XenApp Services Sites T [ ste URL [
Create Site
Create Site [x]
0O " View »
citRiX ot
Specify Point of Authenfication H ree »

‘Specify whene user authentication takes place:

At Web Interface B

The users
fr

ofbult
St explicit, pass-through, and smart card.

including

Webserver

£ omctamenicston

< Back Next > Cancel

Orstert| |G & | WebInterface |[@ Gitrix Web Interface . -0
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#3 184.73.197.3 - Remote Desktop.

¥ Citrix Web Interface Management
File Action View Help

e 7[=Hlm

(D Citrx Web Interface

XenApp Web Sites

Actions.

XenApp Web Sites.
Xenipp Services Sites

Site name

[ Ste URL I

2
citrIX

Confirm Seifings for New Site

Check the summary information below. Te make any changes, click Back. To create the site. click Next.

Site lype
Xenfipp Web

Site name
Xenfpp
IS site
Defaut Web Ste

Default page for IS site
Yes

Example site URL
itp:/AW1/Citroe/XenApp./
Authentication

Authentication poirt Web Interface

«Back Next > Cancel

XenApp Web Sites
Create Site
view

|G Refresh

H tHeo

frsen| | 5 om &

| 1 wen

Interface

|| @ Gitrix Web nterface .

[ &

#3 184.73.197.3 - Remote Desktop.

¥ Citrix Web Interface Management

File Action View Help

&2 [ Film [
(D Citrx Web Interface " Actions
[
e XenApp Web Sites o web .
XenApp Services Sites Site name [ ste URL [
Create Site
Spnfy Initial Configuration - XenApp View »
CiTRIX B e
Specify Server Farm [t 4
‘Specify details of the server farm providing the resources. Settings can be updated after initial
configuration using the Server Farms task.
y  Femname [Fam1
Servers fn failover order):
Selec [ localhost Move Up
Wove Down
ad. | e | Remove |
XML Service port: [20
Trnsporttpe:  [HTTP -
SSL Relaypor:  [443
Next > Cancel
Oostart| | oM@ | webInterface || citrix web Interface .. i

Web Interface:

Confirm settings.

Web Interface:

Configure Initial Configuration.

Use localhost for now, until
we get the XenApp servers
installed.
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Web Interface:

Authentication: Explicit

Web Interface:

Allow any domains.

[ Citric Web Interface

XenApp Web Sites

Actions

XenApp Web Sites.
XenApp Services Sites Site name. [ Site URL
Speci Configuration - XenApp
CiTR};
Configure Authenticaion Methods

Specify how users authenticate when logging on to aceess their resources. Note that some of these:
authentication methods may require additional configuration of your system before they will operate

Authentication methods (selectane or more):
W Explct
™ Passthrough
I Passthrough with smart card
™ Smat card
™ Anomymous™
* Not supported by XenDesktop.

< Back Next » Cancel

XenApp Web Sites
Create Site
View

|6 Refresh

H nep

Oostart] | om0 @& | | webnnterfce

|[@ Gitrix Web Tnterface .

- Remote Desktop

[ Citric Web Interface

XenApp Web Sites

Actions

% XenApp Web Sites.

XenApp Services Sites Site name. [ Site URL

Lo |

Selec

.
CiTRIX

Domain Restriction

You can restrict access to users in selected domains. Settings can be updated afer initial configuration
using the Authentication Methods task
' Allow any domains

Restrct domains to the folowing:

Domain list

Add Edit Remove

Note: Users will be required to enter a domainname in the Demain box on the
Logon screen. Both domain user name and UPN format logons will be
permitted.

< Back Next > Cancel

XenApp Web Sites
Create Site
View

|6 Refresh

H nep

Oostart] | om0 @& | | webnnterfce

|[@ Gitrix Web Tnterface .

e
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197. Remote Desktop

File Action View Help

Web Interface Management

Web Interface:

e 7[=dm

Select screen appearance.

Display the header area and navigation bar.
including the Messages and Preferences
buttons.

< Back Next > Cancel

[ Citrix Web Interface " Actions
g
XeniApp Web Sites Seabep Meb Sics o N
Xenipp Services Sites Ste name [ Site URL
Create Site
*
CiTRIX & rebe
Specify Logon Screen Appearance: Help »
& Minimal
Display only the logon fields forthe selected
E authentication method.
=
Note: The Messages and Freferences buttons
Sl will not appear on the Logon screen.
© Ra

|

. Web Interface

| (D Citrix Web Interface ...

#34184.73.197.

File Action View Help

¥ Citrix Web Interface Management

Web Interface:

e 7[=Hlm

Select resource type.

(D Citrx Web Interface

- Actions
-
XeniApp Web Sites XenApp Web Sites TS R
Xenhpp Services Sites T [ ste URL [
Create Site
Specify Initial Configuration - XenApp View R
3
CITRIX & Refresh
Select Published Resource Type Help 4
Select the types of resources available to users. Setings can be updated after iniial configuration using
the Published Resource Types task
) & Oniee
Users access applications, content, and deskiops hosted on remote servers
Selec
© Offine
U ions to heir deskiops locally. Users must
install the Citiz offineplugein.
© Dusl mode
U beth nden content, and
desklops, all on thesame site.
<Back Next > Cancel
Costart| | G & | | webInterface || citrix web Interface ..

[ &
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Web Interface:

Confirm and finish.

Services Site:

If users will access applications
using the Citrix Plugin, you
need to configure a XenApp
Services Site.

From Web Interface
Management, select XenApp
Services Site -> Create Site.

IIS: Default Web Site
Path: /Citrix/PNAgent/
Name: PNAgent

#3 184.73.197.3 - Remote Desktop

¥ Citrix Web Interface Management

Fle Acion View Help

e=sEHE |

Citrixx Web Interfa - Actions
EE ‘:w:W':NE’b ;;s XenApp Web Sites
XenApp Web Sites -
% XenApp Services Sites Site name. [ Ste URL | e
Create Site
Specify Initial Configuration - XenApp View N
e,
CIiTRIX & e
Confirm Settings H Hep >

Check the summary information below. Te make any changes, click Back.

Farm name
il Fam1

localhost

XML Service port
2

XML Service transport type
HTTP

Authentication methods:
Explicit

Domain restriction
Alow any domains

Logon screen
Minimal =l
<Back [ Freh | Concel |

Drstart| | L W@ |[@ Gitrix Web nterface .. s

| 1. web interface

#% 184.73.197.3 - Remote Desktop

F* Citrix Web Interface Management

Fie Acton View Help

B E |

[ citrc Web Interface S - -
% XenApp Web Sites 8] XenApp Services Sites A 7 -
XenApp Services Sites Stte name I Ste URL |
Create Site
i d view »
CITRIX o
H rep 3

Specify IIS Location

Specify the IIS location in which the site is hosted. This determines the URL for users to access the site.

lISste:  [Defautt Web Ste =

Path [/Gtrie/PNAgert

S Name:  [PNAgent

Next > Cancel

Create a new XenApp Services site. Users access resources using the Citrix online plug-n [

Oistart| | M @ | weblnterface |[ G Gitrix Web Taterface 1)
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ix Web Interface Management

File Action View Help

Check the summary information below. Te make any changes, click Back. To create the site. click Next.

Site type
B | s sevices

S | Site name
PNAgent

IS site
Default Web Site:

Default page for 1S site
No

Example site URL
hitp://W1/Citroe/PAgent/

«Back Next > Cancel

&2 [ Film [
[ Cirix Web Interface = - -
% XenApp Web Sites ] XenApp Services Sites = ;
XenApp Services Sites. “Sie name Tse UAL ;
Create Site
] g View »
crrk!x G Refresh
Confirm Seifings for New Site B e ,

Create 2 new XenApp Services site. Users access resources using the Citrix online plug-n

Orstart| | om0 @& | | webInterfece || @ Gitrix Web Interface .

[ &

2318 197.3 - Remote Desktop.

¥ Citrix Web Interface Management

File Action View Help

Specify details of the server farm providing the resources. Settings can be updated after initial
configuration using the Server Farms task.

o - [Fam1
Servers in fallover order):

Selec localhost Move Up
Wove Down

[ ad | e | Remoe |
XML Service port: [0

Tenspottype:  [HTTP 7]
SSLRelaypot:  [483

€= [Fmldlm
(D Citrix Web Interface m m Actions
% Yenipp Wb Sites B XenApp Services Sites N
XenAipp Services Sites Ste name [ Ste URL [
Create Site
*
ciTRIX & e
Specify Server Farm H tHeo 3

Create 2 new XenApp Services site. Users access resources using the Citrix online plug-n

Orstart| | om0 @& | | webInterfece || @ Gitrix Web Interface .

[ &

Services Site:

Confirm and install.

Services Site:
Configure.

Use Localhost for now.
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Services Site:

Select Published Resource
Type.

Services Site:

Confirm.

197.3 - Remote Desktop
¥ Citrix Web Interface Management
Fle Acton View Help

EC Al Call e

Select the types of resources available to users. Settings can be updated after initial configuration using
the Published Resource Types task.

@y Onine
u icafions, content, and desktops hosted on

Selec
 Offline.

L lications to their deskiops locally. Users must
install the Citrix offline plug-in.
 Dual mode

u: il ications and onli lications. content, and
desktops. all on the same site.

< Back Next > Cancel

[ Citrac Web Interface = = -
% XenApp Web Sites [E] XenApp Services Sites Ao -
XenApp Services Sites Ep— et
Create Site
Spet I

i View »

CITRL i Refresh
Select Published Resource Type B e R

Create  new XenApp Services site. Users access resources using the Citrix online plug-in

Dostart| | 3 M @ | | Webinterface |[ G Gitrix web Tnterface —

- Remote Desktop

Check the summary information below. To make any changes, click Back

Farm name:

& v Fam1

localhost

XML Service port
a0

XML Service transport type
HTTP

Online

< Back I Finish I Cancel

[@ Citrix Web Interface = - -
% XenApp Web Sites @ XenApp Services Sites ‘Actions -
XenApp Services Sites ‘Ste name. T Ste URL
Create Site
E2 View »
|6 Refresh
H tee »

Create a new XenApp Services site. Users access resources using the Citrix enline plug-n

Lrstart| | G @ | | Weblnterface |[@ Gitrix Web Tnterface .

e
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GO [ wrse

Fle Vew Help

-5 e

-4 StartPage
=-95 WI (CTTRDALABS adminis
[} Application Pocls
&, FTP sites
(@] Sites

@i’ Sites

Filter:

- [fco - show Al | Groupby: Mo Grouping hi

Name =

[ status

| Binding

[ Path

@ Default web Site

4

D
1

Stopped (h...

=180 (tip),808: (net.tcp), * (net.pi...

%SystemDrive jinetpub

4] B
Ready

Iostart| | % M @ @ | & locahost -Bing -Windon... | () Cirix Web Interface Ma... | [ Tnternet Tnformation . @) Cirx Xenépp -Lagon - ..

(i) This site has mutiple bindings

& Add Web Site....
Set Web Site Defaults...
Edit Site
Bindings. .
[] Basic Settings...
Explore
Edit Permissions...
K Remove
Rename

B

View Applications
View Virtual Directories
Manage Web Site
> Restart
Start

av

Stop

Browse Web Site
Browse *:80 (http)
Advanced Settings...
Configure

Failed Request Tradng...
Limits...

@ rep

Orline Help

[=]Features view

ontent View

11S:

Make sure IIS is started and
running.
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Secure Gateway:

From the Amazon EC2 Navigate

to the Secure Gateway

installation directory on the

installation media.

Secure Gateway:

Launch the CSG_GWY installer.

Secure Gateway

Install the Secure Gateway

note Desktop

CiTRIX

Computer = New Volume (D:) - XenAppSsp3 - XA5_FP3 PLT_ML1 - Secure Gateway - Windows -

* & [searn

Orgarize v

Favorite Links
F bocuments
B Fictures
B music

Mare %

Folders.

&, LocalDisk (c:)

|| XenAppSsp3

|, Licensing
. Profie Ma

. Windons
| da

J. Workflow

b9 C on S1CLaraigel

|| SetAlthddressServia
|| XAS_FP3_PLT_ML1
. Administration
| Citrix Receiver anc
| Citrix Streaming Pr
|| HOX Components |

| Provisioning Servic
|| Secure Gateway

. service Moritoring |
|. Single Sign-On
|| Web Interface

= ews -

|-lsze || Tage |-

2B

v

El

|, New volume ()
| setaltaddressservice

nagemer

s

Studio O

| XenApp Prep Utiiiy
| 4; XA5_FP3_PLT MLL
.} HD DVD-ROM Drive (E:)

ol |

lemote Deskto

4/26/2010 9:12PM  File Folder
4/26/2010 9:12PM  Windows Instale... 8,373K8

|, Licensing

I
| Service Mo

|| Citrix Receiver anc
. Citrxe Streaming Pr
| HDX Components {

| Profile Managemer
|, Provisioning Servic
| Seaure Gateway

. Windows

ritoring—)

| Single Sign-On

7
Gk)v [~ Computer - New Volume (3:) - XenAppSsp3 - XAS_FP3_PLT_MLL - Secure Gateway - Windows - v (&5 [searcn (2]
Orgarize v (= Views v [Slinstal ~ @
Favorite Links LI I-lsze |-|vags |-
Jija 4/26(2010 9:12PM  File Folder
I Doaments Bese_awy 4[26(2010 9:12PM  Windows Installe...  §,373KB
[E Pictures
I music
More 3 Secure Gateway 3.2 Setup [T
Folders v Welcome to the Secure Gateway
bz, ocaipisk () A 3.2 Setup
|, New Volume (D)
|| SetAltAddressService
. XenApp5sp3 Itis strongly recommended that you exit all Windows programs
|| setaltadressservic befare unning this setup program.
| XAS_FP3_PLT_MLL
iy Click Cancel to quit the setup program, then close any progiams
| Administration

you have running. Click Next to continue the installation.

WARNINE: This program s protected by copyright law and
intemational treaties.

Unauthorized reproduction or distibution of this program, o any
portion of it. may fesultin severe civil and ciiminal penallies. and
will be prosecuterd to the mazimum extent possible under [aw.

| Web Interface
| Workflow Studio 0
|/ XenApp Prep Uity
|4 XAS_FP3_PLT_MLL
|3 HD DVD-ROM Drive (E:)
2 ConSitlaraigez |
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#3 184.73.197.3 - Remote Desktop.
[ Windows

Secure Gateway:

G_Qc [ 77~ computer ~ New Volume (D:) - XenAppSsp3 ~ XAS_FP3_PLT_MLL = Secre Gateway ~ Windows - * B&[sean |nSta|| |n the f| rst Segment Of
Organize v |5 Views v j5)mnstal ~ @
Eavorite Links Name = | +| Date modified | -] Type || size | -] Taes |1 DMZ'

K 4/26/2010 9:12PM  File Folder
[E) Documents Blcse_awy /262010 9:12PM  Windows Installe...  8,373KB
[E Fictures

& Music

More »

i Secure Gateway

Setup [_[C1]

Folders Installation Mode

:
L citRIX

|, New volume (B:)

<

SetAltAddressService Installation mad

| XenApp5sp3

|, SetAltAddressservio % Secure Gateway

| XAS_FP3PLT ML1 Typicall, you would instal the Secure Gateway in 4 single-hop DMZ, the fist
Administration

segment of a double-hop DMZ. o inside your secure netiork.
Citrix Receiver anc

4 Citrix Streaming Pr " Secure Gateway Prosy
| HDX Components { )
. Typically, you would install the Secure Bateway Proxy in the second segment of
L Leensing a double-hop DMZ. immediately preceding your secure network.
Profile Managemer
Provisioning Servic

| Secure Gateway

. Windows
ki ia
Service Monitoring— Back [ Met> | Cancel
Single Sign-On

| Vieb Interface

. Werkflow Studio O

| XenApp Prep Utiit,
| 1) XA5_FP3_PLT_ML1
|3 HD DVD-ROM Drive (E:)
fc® Con SICLeraigel02 ;I

C56_GWY Date modified: 4/25/2010 9:12 PM
Windows Instaler Package Size: 8,17 MB
Date created: 3/2/2010 3:57 M

Lrstart] | 5 @ @ | € ocshost -6ing ... | @ Cirix Web Interfa, . | 63 tnternet nformat..

(@) Citrix XenApp - Lo... | ¥ Windows | 1) Secure Gatewa... =10

%% 184.73.197.3 - Remote Desktop
[ windows

Secure Gateway:

7\
6 (S [1~ Computer ~ New Volme (D:) + XenAppSsp3 = XAS_FP3_PLT_MLL - Secure Gateway ~ Windows - > B [searcn

Select the Network Service
Organize v Eviews v j5lmstal v
Eavorite Links Name = | +| Date modified | +| Type |~ sze <] Tags [H account

5 4/26/2010 9:12PM  File Folder
I pocuments Blese_awy #/26/2010 %:12PM  Windows Installe...  8,373KB
[E Pictures
B Music
More » B Secure Gateway 3.2 Setup [_ (O[]
Folders " Service Account

.
JES, Local Disk () -] Select a service account clm!x'

|, new volume (03)

., SetaltaddressService
)/ XenApp5sp3
| SetAltAddressServic Secue Gateway runs under 3 wser acoount (o provide credenials and delermine
8 piivleges. The local user accounts listed below meet these requirements. Select 2
; XA5_FP3 PLT ML1 User account under which you want to un Secure Galewap.
. Administration

. Citrix Receiver anc
. Citrix Streaming Pr
HDX Components { Account
Licensing

Profile Managemer
: < Passyord:

. Provisioning Servic
| Secure Gatenay
. Windows

ja

i Service Monitoring— < Back New> | Cancel
s single Sign-On
| Vieb Interface
Workfiow Studio O
|| ¥enApp Prep Utilit
| 1) XA5_FP3PLT_ML1
.3 HD DVD-ROM Drive (E:)
a2 Consilaaigdoz ||

CS6_GWY Date modified: 4/26/2010 9:12PM
Windows Instaler Package Size: 8.17MB
Date created: 3/2/2010 3:57PM

Crstart| | 3 M @ @ | @ locahost -Bing -... | (@) Gitix Web Interfa... | ¥3 Intemet Informat.. | @) Girix XenApp - Lo...

# Windows [ secure Gatewa. | ) @i
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SeC ure Gateway: Remote Deskto

Launch the Secure Gateway gc)v [~ Computer - New Volume () - XenppSsp3 - XAS_FP3_PLT_ML1 ~ Secre Gateway ~ Windows - + 82 [5an
installation wizard. Somme T e il -

Faverite Linke Name _+ | -] Date modified | -] Type |-lsize  [-lTass -]
i ja 4/26/2010 9:12PM _ File Folder
[El Doaments Bese_awy 4/26/2010 9:12PM  Windows Installe. .. 8,373KB
[E pictures
B musc izard
s
More Secure Gateway configuration level for Citrix XenApp.

H i
- CITRIX' oo

|, Local Disk (c2) | & Standard

. New Volume (D:)
Configure typical Secure Gateway

| SetltAddressService
parameters.
. XenAppSsn3
| SetAltAddressServic © Advanced
JJ XAS_FPS_PLT MLL Configure all parameters for the Seaure
| Administration Gateway.

. Citrix Receiver anc
. Citrix Streaming Pr
| HDX Components |
. Licensing

| Profile Managemer:

. Provisioning Servic
| Secure Gateway

| Windows
L
Service Moritoring |
|, single Sign-Oon
| Web Interface = Back I Next > I Cancel Help.
| Workflow Studio O
|| XenApp Prep Utiity
|, ¥A5_FP3_PAT ML1
.5 HD DVD-ROM Drive (E:)
2 consiaaigenz

CSG_GWY Date modified: 4/26/2010 9:12PM
Windows Installer Package Size: 8.17MB
Date created: 3/2/2010 3:57PM

Lrstart| | 3, B @ @ | 8 ocalhost -Bing .. | (D) Citix Web Interfa... | ¥ Intemet Informat... | @) Girix XenApp -Lo... | # Windows | secure Gatewa. | -) @ik

Secure Gateway: Remote Desktop

—
@w [ 77~ Computer + New Volume (B:) - XenAppScp3 + XAS_FP3_PLT_M.1 - Secure Gateway ~ Windows ~ - [ [sern

Use the existing certificate, or
create one in IIS.

Gl

Orgarize v (= Views v [Glinstal ~

Favorte Links Name ~ | -] Date modified | | Type |-l sze | -] Tags [=]
| ja 4/26/2010 9:12PM  File Folder
IEl Doaments Besc_awy 4/26/2010 9:12PM  Windows Installe...  8,373KB
[E Fictures
I music izard <]
More 3 Select 3 server certificate
0 The fllowing server certficate(s) were found on your
Folders v C| i system. Please select the server certificate to be used
by the Secure Gateway.
&, LocalDisk () |
New Vilume (05) To view certificate detals, select an entry in the st and
j=s hew Voume (O dick View.
|| SetAltAddressService
. Xenappssp3 Certificates found
)| setAltaddressservic
|| XAS_FP3PLT ML1
| Adnministration

. Citrix Receiver anc
. Citrixe Streaming Pr
HDX Companents {
Licensing

. Profile Managemer

View...

. Provisioning Servic
| Secure Gateway
| Windows

]

. Service Monitoring—|
. Single Sign-On
. Web Interface < Back I Next > I Cancel Help
. Workflow Studie O
J/ XenApp Prep Uity

| 4; XAS_FP3_PLT_MLL
|-} HD DVD-ROM Drive (E:)
lx® Con SICLeraigein2 LI

C5G_GWY Date modified: 4/26/2010 9:12 PM
Windows Installer Package Size: 8.17MB
Date areated: 3/2/2010 3:57PM

Lrstart| | 3 M @ @ | & ocahost -Bing -... | (@ Gtix Web Interfe... | ¥ Internet Informets.. | @) Gitrix Xenapp -Lo... | # Windows || secure Gatewa.. | @y
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—
6 Lr [1 ~ Computer ~ New Volme (D:) ~ XenAppSsp3 ~ XAS_FP3_PLT_ML1 ~ Secure Gateway ~ Windows -

v 883 [search

Organize v |5 Views v j5)mstal ~ @
Eavorite Links Name = | +| Date modified | -] Type || size | -] Taes |1
| ja 4/26/2010 9:12PM  File Folder
IE) pocuments Blcse_awy 4/26[2010 9:12PM  Windows Installe. .. 8,373KB
[E) Pictures
B muse Secure Gateway Configuration wizard El

More » Configure inbound dient connections:

Y The Secure Gateway listens on the specified 1P
CITRIX" -

dress(es) for inbound cient connections.
IV Moritor all 1Py addresses

Folders v
J, Local Disk (€) |

= New Volume (0:) ™| Woritor &l IPys addresses

|| SetAltAddressService TePport: [43
Ji XenppSsp3 face list
| setaltaddressservic
|| XAS_FP3_PLT ML
| Administration Secure Gateway Service Configuration [<]

Citrix Receiver anc

. Citrix Streaming Pr - e P o ) "
i or more of the IP addressesis a dynamic
J HDX Components { e T s T addess changes, existing
Licensing connections are lost and new connections are
not accepted untl the Secure Gateway is
reconfigured with its new IP address, Itis
recommended that you configure Secure
Gateway with static IP addresses.,

. Prafile Managemer
Provisioning Servic
| Secure Gateway

| Windows
J i Glick Continue to use the selected dynamic 1P
address or dick Back to select a static IP
. Service Monitoring—| ddross,
Single Sign-On
Vieb Interface <Back Next >

| Wiorkflow Studio O

| XenApp Prep Utiit

| 1) XAS_FP3_PLT_ML1
.} HD DVD-ROM Drive (E:)

o2 Conslcloaigdz

@] cssewy Date modified: 4/26/2010 8:12PM
Windows Installer Package Size: 8.17MB

Date created: 3/2/2010 3:57PM

[ Secure Gatewa— |-} wik

ostart| | 3 M @ @ | @ ocahost-Bing-... | (D) Gitix Web Interfa... | ¥ intemet Informati.. | @) Cirix XenApp -Lo... | Windows

|\ ~ Computer ~ New Volume (D) ~ XenAppSsp3 ~ XAS_FP3_PLT ML1 ~ Seare Gateway ~ Windows -

> & [search

Galo

Organize v (Eviews v Slmstal v

Favorite Links Name = | -] Date modified | =] Type | =] size | -] Tags |=]
i ja 4/26/20103:12PM  File Folder
I/ pocuments Blese_awy 4/26/2010 9:12PM  Windows Installe...  8,373KB
[E) pictures
ﬂ Music Secure Gateway Con rd [ x]
———————
More Configure outbound connections
Outbound connections
Folders v

L
CITRIX'
& No outbound traffic restrictions

Vs, Local Disk () =

. New volume (0:)

| SetltaddrassService " Use the Secure Gateway Proxy
. XenAppSsp3
| SetAltAddressServic Corfigure.
| XAS_FP3_PLT ML1
| Administration

€ Use an Access Control List (ACL)

Confiaure, .

| Citrix Receiver anc
Citrix Streaming Pr
HDX Components |
Licensing
., Profile Managemer
| Provisioning Servic
Secure Gateway
|| Windows
]
. Service Monitoring—]
| Single Sign-On
Web Interface <Back I Next > I Cancel Help
Workfiow Studio O
. XenApp Prep Utilit
[ XA5_FP3PLT MLL
.} HD DVD-ROM Drive (Es)
22 Conslilaaigdoz ||

@] Cseswy Date modified: 4/26/2010 8:12PM
= Windows Installer Package Size: 8.17 MB

Date created: 3/2/2010 3:57PM

[ Secure Gatewa—. | W

Drstart| | 3 B @ @ | @ locathost -Bing - .. | (B citix Web Interfa... | ¥ Intemet informati... | @) oirix Xenapp -Lo... | ¥ windows

Secure Gateway:

Use port 443 for secure
communications.

Note: Ignore the warning for
dynamic IP Addresses, as

you will be using an Elastic IP
Address from Amazon - a Static
IP.

Secure Gateway:

No outbound restrictions.
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Secure Gateway: £2 164.73.197.3 - Romote Desktop

Use localhost for STA
temporarily.

Organize v i Views + [a7Explore |33 Share @ fions
pApp Web Sites. -
Favorite Links
Create site
[E/ Documents } ustel Details of the server running the Secure Ticket Authority
) (T4 View >
[ pictures J fipro ) A s oie s —ryer(s) runing the
B Music 1 histor clTn Secure Gateway Configuration wizard  [E7 |EAFAYEY Refresh
More » Jilogs el R
. temp ~Secure Ticket Authority (STA) detalls ————
Folders v L wwwt nApp - Edit Settings -
&, Lok (c) =] P localhost I Server Farms
. inetpub Pathi [ sripts/CtxsTA.di Authenticaton Methods
|, AdminScripte
i e Wb Site Appearance
s
fiproot Secure Access
. history HEEE SR 7 Resource Types
| logs [~ Seare traffic between the STA and the b | [oeee |
el Enaea Cient Deplayment
wwnroot TCPport [T I Use defat Clent-Side Proxy
aspret_di

Session Preferences

. Citrix Secure Gateway Configuration wizard
. Workspace Control
|| XenApp

J app_c Site Maintenance 3
app_c :: The Secure Ticket Authority specified cannot be contacted. |
auth L
bin o <Back ey Help
Toignore the warning and enter the ID dick Continue.
AdminScripts
® File Folder

} Date modified: 4/27/2010 5:05 PM
= |

! |_»||
= \ [

Drstart| | % B @ @ | & ocahost ... | (D atrixwebint... | §5intemetinfor... | @ crixxenapp .| £ xasFra .. | 7 netpub [ secure Gate... [} @

Secure Gateway: 43 184.73.197.3 - Remote Desktop

R

Access will be Indirect.

K& [searcn
Organize v 5 Views ~ [27Explore | 33 Share @ [pons
= e e = = = nApp Web Sites -
Favorite Links Home_— —
Admit Create Site
| Documents | custe Details of the server running the Web Interface
view ,
B Pictures “:\Dr; I — fosh
B musc == & Indrect: To access the Web Interface, Refre:
More 3 logs users enter the URL of the Secure Gateway. Help V
o) IV Installed on this computer —
Folders v W " Direct: To access the Web Interface, users PAPP - Edit Settings -
& LoDk () 4] enter the LRL of the Web Interface. Server Farms
. inetpub Detaik Authentication Methods
AdminScripte
mnsee Web Site Appearance
| custerr FODM:  localhost
. fiproot . p— Secure Access
ecire waffi between
. history TGP part: [50 I ithe b Tnterface and Resource Types
| logs the Secure Gateway:
. Clent Deployment
I, temp
. wwwroot Clent-Side Proxy
1 aspnet_di Session Preferences
| citi
S Workspace Cantrol
|| ¥enigp
app_c Site Maintenance »
J app_c Preview Site
I auth
sbin o] < Back I Next > I Cancel Help Help
AdminScripts
% Fie Folder
} Date modified: 4/27/2010 5:05 PM
q (|
Dane ‘ [
Costart| | 3 B @ @ | & ocabhost -Bin... | () itrix Web Int... | G Internet Infor... | @) Citrix Xenape ..
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.197.3 -

Remote Desktop

»

Organze v = Views v [W7Explore 23 Share

Name —

fiprol

logs
temp
W

inetpub
AdminScripts
assterr

| frproot

. history

. logs

temp
wwroot
|, aspnet_cli

Seaure Gateway configuration complets

!
1 .

\. histor clTRlX' Starting the Secure Gateway.
!

1

| ¥ Start the Secure Gateway

et > | Firisfi I Help

AdminScripts
Fle Folder
Date modified: 4/27/2010 5:05PM

@ pons
pApp Web Sites -
Create Site
View »
Refresh
Hep »
PApp - Edit Settings -

Server Farms
Authentication Methods

Web Site Appearance

Secure Access

Resource Types

Client Deployment

Client-Side Proxy

Session Preferences
Warkspace Contral

Site Maintenance »
Preview Site

Help

Favorite Links T‘ Secure Gateway Con
‘Admi
[/ Documents d ot
[E Fictures )
& music i
Mare .
Folders .
&, Local Disk () 4]
¥
4

[owe

Costart| | 3 M @ @ | @ locahost -in... | (D Citrixweb Int... | &5 ntemetinfor... | @) citrix Xenapp .. | # xa5FPIPLT... | 2 inetpub |[F Secure Gate— |5 il

Secure Gateway:
Finish and Start the Gateway.
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Launch AMI:

From the Amazon EC2
Dashboard, select AMls.

Find the image that we created
as XenApp Base Image.

Launch an instance of this
image.

Follow the remaining prompts.

Assign IP Address:

From the Amazon EC2
Dashboard, select Elastic IPs.

Allocate a new IP Address and
assign it to the instance.

XenApp Server 1

Install the XenApp Servers

a Firefox

CITRIX

> C X & (Wn le.aws. amazon, =EC

v '| @' Google

Regiol

US East ¥

Wil aws.amazon.com AWS | Products | Developers | Community | Support | Account Welcome, Citrix Test = Settings | Sign Out
Amazon Elastic Amazon
Amazon EC2 || H CloudFront

i Launch || .&5pot Request | [ Register New AMI || [ De-register |y Permiesions

[T3 Showmide || & Refresh

Viewing:| Owned By Me [ All Platforms ][

| 1€ € 1tozzofzzam= 3 3

> EC2
AMI ID Visibility Status Name Description 4+ Image Size
INSTANCES p 2
et @am\-ﬂﬂaﬂe Private D available Base Image iB L
> Instances =
O ami-ch7f93a2  Private @ available XenApp5.0_Sel iB :J
> Spot & @ Lk Reguest Spot Instance |
O  @lami#22c9a  Public @ available XenApps 0_AGS| Edit Permissions 1]
[MaceEs De-register AMI
» AMIs . O @ ami-08947961  Public @ available XenApp5.0_Sel g iB
» Bundle Tasks [0 @) ami-aect2bc? | Public @ available XenApp5 0_Secure( XenApp 5.0 with Se 30 GiB
ELASTIC BLOCK STORE O ami-f339d69%a  Public [~ ] ava\\am XenApp5.0_32bit V| XenApp AMI 30 GiB
> Volumes 1 EC2 Amazon Machine Image selected
> Snapshots @ EC2 Amazon Machine Image: ami-4743ad2e 4
NETWORKING & SECURITY —{ | AMI ID: ami-4743ad2e
> Elastic IPs Name: Base Image
> Security Groups Description: Base Image
> Key Pairs
. Load Balancers Source: 519701941432/Base Image @l
© 2008 - 2009, Amazon Web Services LLC or its affiliates. All right reserved. Feadback Support Privacy Policy Terms of Use An amazoncom. compary
https:/fconsole.aws.amazon. com/ec2/home# D |

home #c=EC

Google

Associate Address

Address: 184.73.213.224

Instance ID: 144225926 v |

Cancel [/
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Command Prompt

C:\>mstsc sconsole

-
ﬁ Remote Desktop Connection

Remote Desktop
Connection

Computer:

Username:  |P-DAD30SAB Administrator

You will be asked for credentials when you connect.

184 73.213.224 hd

Connect H Cancel ][ Help

] [ Ciptions == ]

ﬁ 184.73.213.224 - Remote Desktop

EEE

R network and Sharing Center =15]
(= [ - conrolPand - Netork and sharing Center + & [seren (2]
(7]
Tasks Network and Sharing Center
View computers and devices View full map
Connect to a network:
Setup a connecton or netnork i L =
p i T—
Manage network connections i Local Area Connection 2 Status |nmm
Diagnose and repair m — | Bl Local Area Connection 2 Properties
Netwerking |
5 Wetwork (Publc | ©OMNect tomize
il py4  Comnectusing:
Access
V6 i RedHat pawymmms
Comnection "d I = Internet Protocol Version 4 (TCP/IPv4) Properties 1]
Medic
Dural General IAItEmatE Configuration |
3 . spee  This connectio
Sharing and D You can get IP settings assigned automatically if your network supports
- g 05 assig y if ippo;
—| B " Client  this capability. Otherwise, you need to ask your network administrator
Netwark discovery g JElgosr  for the appropriate IP settings.
File sharing e
[ -+ Intem: €% Obtain an IP address automatically
Publc folder sharing - actwity -lntem e the following IP address:
v Y
Printer sharing - Linke diesss
= Lried] IP address; s
Password protected : Subret mask: . . .
=) Install Default gateway: .
Show me al the fies _—
Show me all the shart =
¥ Pro Transmissior € Obtain DNS server address automatically
;"::;’jig; % Use the following DNS server addresses:———————————————
Preferred DNS server: 184. 73 . 213 . 80|
— Alternate DNS server: .

Advanced..

See also

Intermet Options

Windows Firewall

e

Lrstart] | 3, W | & Network and sharing Ce... |[T Local Area Connectio...

(=t

Connect:

Connect to the instances IP
Address you just assigned, by
running Remote Desktop from
your local computer.

From a command prompt:

mstsc /console

DNS Settings:

Navigate to Control Panel ->
Network and Sharing Center.

In the IPv4 Properties, use the
following DNS server address:

184.73.213.80.

Note: This address will

be different for your
implementation. It is the Elastic
IP Address you assigned to
your Domain Controller through
the Amazon Console.

62



CiTRIX

XenApp Server: ﬁeCZ'134'73'11ZrEE,camput&1.amazc|naws.wm - Remote Desktop

As a matter of convenience it
is recommended to change
the hostname to something
meaningful.

Navigate to Computer -> Right-
Click -> Properties.

i% Server Manager !7- |
A Command Prompt

Administrator

# l Windows Update
[

Documents.

@ Internet Explorer
d
o ] Notepad
Netwark i
M
@ SQL Server Configuration Manager ==
- Control Panel Map Netwark Drive...
®| E—— R e oot Disconnect Network Drive...
R s
= + Show on Deskiop
EC2ConfigService Settings. Help and Support Rename
Run...
Windows Security

» AlPrograms.

[stert search L2/ o) a |»
ostart | 3, B | . ticensing |

XenApp Server: ba} 1&4._73.213.224 - Remote Desktop. (NEIEY

Change Settings for Hostname a
and join the domain. (JC) [ - comsrmst~ 5m B

In this example: e T |

I Device Mz
. - Computer Name | Hardware | Advanced | Remote |

Computer Name: WI ® remotcs | B8

@ adancee A :m:vn;smmemmng information to identfy your computer reserved
Domain: citrixlabs.com e ||

o e
. “Accounting g ——
RebOOt and ReCOﬂneCt US|ng Full computer name: ip-0AD308AB ‘You can change the name and the membership of this
computer. Changes might affect access to network resources.

Remote Desktop Workgroup: WORKGROUP More infommation

To rename this computer or change fts domain or
warkgroup. click Change. Computer name:

heas|

Full computer name:

=i Change settings

Member of
& Domain
Iq{mdahs com]

€ Workgroup ggr[li.flined .

See alsa i £ 1ORKGROLE
Windows Update Learn more online...
s

Dstart| | %M | 1 system [ System Properties ik
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#3 184.73.213.224 - Remote Desktop

citrixlabs\administrator

How o

Switch User

" WindowsServer2008
Datacenter

#3184.73.213.224 - Remote Desktop FEX]

=

Y xas_Fp3_PLT_MLL [_[Of ]

o]

o . ]
* K& [search 2]
[_]

. Favori OO tﬁ; + Computer =

B bor 1 Gitrix XenApp Components Installation
B w Organize ¥ 5= Views
B [ Favorite Links
& Re B F) Documents
B s 0 e picwres

bR B vesc

B (5 Recenty changed
l B searches
| Public

Component Selection
Select the components you want to instal
2 =] Ciin Xenkpp 5.0 Companents
X - Ciiix Licensing
37| Access Management Console

ace
- =k Citi Rerdpp

S5+ Passthiough Client

e =3 > | Citix ¥endpp Plugin for Steamed Apps

=3~ | XenApp Advanced Configuration

Description:
Provides users ith access to applications thiough 2 standard Web biowser.

Defank <Back [ Mews |

Cancel

Folders A

HD DVD-ROM Drive (E:) XAS0_WS08_EN Space free: 0 bytes
Total size: 1.36GB
File system: UDF

A"Shrt” -] | | xasFp3pT ML |, Newvolume 0 | ;M Computer | ﬁomxsvsbems»cml (€ Download Manag... | 15) Citrix XenApp C.. |12 w@ls

XenApp Server:

You will need to login with
domain credentials. For
example:

citrixlabs\administrator

XenApp Server:

Navigate to the XenApp install
folder on drive D..

Install XenApp Server.

Note: Microsoft Visual J# 2.0
can be downloaded from
Microsoft’s website.

Note: If you receive an error
message that Web Interface
cannot complete installation
due to the fact that <domain>\
None is an invalid user or group,
Remove the machine from the
domain, install Web Interface,
and the join the domain again.
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XenApp Server: #3 184.73.213.224 - Remote Desktop
Enable Passthrough

~ New Volume (D:) » XenAop3so3 » XA5 FP3 PLT ML1 v <. ) E—

Authentication. T

B C =) Computer -]
Favori K [z 1D DVD-ROM Drive (E:) XAS0_WS08_EN =
E po

Fic| Fe
W Organize v 1 Vi
Re B JE)| Favorite Links

B E [ ooamens ication for the

. Put B E pictures Select the desired passthiough authentication behavior

B & B s To pass your local Windows rame: and password automatically from the client to the server, vould you
B More » like to enable passthrough authentication

Folders & Yes

[ Hp DVD-ROM Drive " No
|, Administraion 1 onaple passthrough authentication a5 the logon method from the passthrough client to the server,
| Citrix Password M click e If you do ot enable passthiough authentication now and wan ta enable it ater, you must
. Citrx Streaming P teinstalthe passthuough client a this server,
, Clients
. Documentation
. EdgeSight
. Licensing
| Network Manager
. Resource

| en
! Resources ¢ Back Cancel

| Secure Gateway

. SmartAuditor

| Support

|| Appstreaming  —|

207200 BT 20 AT TEXT DOCOMENT TR

autorun  Date modified: 7/29/2008 12:35PM
Application Size: 237 KB
Date created: 7/29/2008 12:35PM

Dvstart| | 3%, M & | awndowsExplorer  ~| & Gitrix Systems » Gitrx... | & Download Manager -W... | & 0ld version of Java Ru... |[15] Citrox xenapp Comp... |2} @'{bl

XenApp server: #% 184.73.213.224 - Remote Desktop:

Use localhost.

or
Favori K [F: 1D DVD-ROM Drive (E:) XAS0_WS08_EN (O] ]
I oo ‘s()v P JBX=] (& Citrix Xenapp Components Installation
B e m
B wE r
5 Re B JF) Favorite Links
B s BB I Documents Server Address for the Passthrouah Client
L5 B “You selected Cilik Xentpp Plugin as the passthrough cient on this server, Cilix XenApp Plugin must

ictures be aware of the loation of the b server hasting the t/eb Inteiface. Enter the LIRL of the 'Web
B 5B s server that is hosting the Web Interface.

LB vere s

Organize v |5 vie

Server UAL:

Folders [lecainost

& HD DVD-ROM Drive

Adnministration

| Citrix Password M

| Citrix Streaming P

|\ Clients

| Documentation
EdgeSight

| Licensing

. Network Manager

. Resource

|l en

| Resources < Back Cancel

Secure Gateway
SmartAuditor 7207200 720 AT TERT DOCTETTT ™o

F Support
| |\ Appstreaming |

autorun  Date modified: 7/29/2008 12:35PM
Application Size: 2378
Date created: 7/23/2008 12:35 PM

Orstant] |G M @ | aWindowsExplerer -] & citix Systems > Gitix

| & ponnioad vanager - ... | & ol verson of Java Ru.. [ 18] itrix Xenapp comp-- [ &L |
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#3 184.73.213.224 - Remote Desktop

- New Volume (D
& New Volume (I

<1} E—n

or C i Computer [_[O]x]
Favori K JF; HD DVD-ROM Drive (E:) XAS0_WS08_EN = [O[x]

[l Do
B ric m
BwEp w

Organize v 132 Vie

& Re B Favorite Links
B s B I/ bocuments Warming!
e =T B Fictures
B 5 @ msc
LB vere »
b
Folders
&% Ho DvD-ROM Drive
|| Administration
. Citrix Password M
| Citrix Streaming P
|\ Clents
|| Doamentation
. Edgesight
. Lieensing
|| Network Manager
| Resource

‘You chose to install the product without instaling a Cirix License Server. & license server
is necessay ta full license the product

£ Install alicense server nows.

@ | alieady have a license server, of will use the product DVD to install one later.

|l en
| Resources
| Secure Gateway

< Back Cancel

SmartAuditor
Support
| AppStreaming |

T2 T2 AT TEXT DOCITENTT Tr

autorun Date modified: 7/29/2008 12:35PM

Application Size: 237KB

Date created: 7/29/2008 12:35PM

Lrsn| | 5 om &

| 1. 4 Windows Explarer

+| 4 citrix Systems »Giix ... | % Download Manager - ... | & 0id Version of JavaRu... |[ ) Citrix XenApp Comp... |-} &Ly

—~
i 1.+ New volume (0;
@ New Volume

or

B rc r
BwE e
5 ReU B Favorite Links
B =@ B [F) poauments Updating §!
b P B BB ecares The features
B &R s
LB Moe »

Folders

Organize + {3 Vie

iD DVD-ROM Drive:

. Administration
Citrix Password M
Citrix Streaming P

. Clients

. Documentation

| EdgsSight
Licensing
Network Manager

. Resource

I en

| Resources

Secure Gateway
SmartAuditor
Support

| ———

[

Installation completed
successfully.

Summary:

7] Access Management Cansole - Diagnostics
7] Access Management Console - Framework
[ "] Access Management Console - Hotfix Managemen'
+..[ ] Actess Management Console - Knowledge Base
[T Access Management Cansale - Legacy Toals
7] Access Management Console - Report Center
] Access Management Console - Web Interface
[ 7] Citrixt Password Manager Console
+..[ 7] License Server Administration =
=
!

4l

Yiew Log

cbo [ Fesh | conel |

autorun  Date modified: 7/29/2008 12:35PM

F b
| ) =

Application Size: 237KB

Date created: 7/29/2008 12:35PM

Lostant] | 5 &

| 1. 4 Windows Expl.. | 48 Gitrix Systems »C... | & Donnload Manag... | & Oid Version of Jav... | 1 Citix XenAop Co... |[48 Gitrix Access M. S

XenApp Server:

We already installed a license
server.

XenApp Server:
Install XenApp Server.

Reboot when finished.
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XenApp Servers 2 through n

Install the remaining XenApp Servers. If you have a need to “scale” serv-
ers, you will need to create additional XenApp Servers, and add them to the
farm.

To do so, repeat the previous procedure for as many XenApp Servers that
are required, giving them different computer names. For example, in our
proof of concept, the XenApp Servers are named the following:

xas].citrixlabs.com

xas2.citrixlabs.com
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Publish Applications:

On the second XenApp Server
(xas2.citrixlabs.com) we

will publish some apps that

are already installed in the
Microsoft Server operating
system. For example, Notepad,
Internet Explorer, Wordpad,
Calculator.

Open the Access Management
Console on XenApp Server 2.

Publish Applications:

Select Applications -> New ->
Publish Application.

We will publish Internet Explorer
as an example application.

#3 184.73.214.55 - Remote Desktop

B Citrix Access Management Con:

Fie Action View Help

sole

Igsbl&\ﬂ

Citrix Access Management Console
Alerts
(5] search Results
My Views
7] Report Center
[} Licensing
[+] Diagnostic Faility
= (3 Citrix Resources
Bl B2 Configuration Tools
] Web Interface
Hotfix Management
= & xenApp
2 28 NewFarmName
& Administrators
1 [} Applications
4 Excel
104 outiook
1P2| Pawerpoint
Word
B (5 Servers
[l xas1
[ xas2
[ Zomes
Password Manager

@& 5.

Hame  y Views_Seaen Applications
[ Contents
‘Common Tasks
Changedisplay » | (Application Choose columns
New [ Type [ status. [ user Connection Type
Save in My Views Installed Appl...  Enabled Explidt
194 outlook Installed Appl...  Enabled Explicit
i T s Powerpoint Installed Appl...  Enabled Explit
Customize display N Word Installed Appl...  Enabled Expliit
Permissions
Import new applications from a
Related Tools
YenApp Advanced el
Configuration Toas <J
Citrix Knowledge Centets
|4 items

[ Launches exemal appliation

CiTRIX'

Select one or more items to view details and associated tasks

Oostart| | 3, m @

| 28 Adminitrator: Command. .. | [ Citrix Access Manage...

#3 184.73.214.55 - Remote Desktop

B Citrix Access Management Console

Citrix Access Management Cor Frne] lorer - Publish Application [x]

CiTRIX'

Choose columns

[ Zomes
Password Manager

Publish immediately

Alerts . y
] Search Resuits CITRIX
My Views
Report Center Name
[} Licensing
[+] Diagnostic Faility
E %%"T“““mﬁ.s ook o Enter the 4 description that you want to be displayed to clients for this application
ools eps
@ weblnterface |
Hotfix Managemen e Display name:
&1 & xenanp Basic [itemet Explore]
24
28 NewFarmiame |, o
& Administrators X X
1 [} Applications. Type Application description:
ES Excel Location
04 outiook
"Pﬂ Powerpoin’ Servers
Word Users
E
BB, Shorcut
presentation
[ xas2

< Back I Next » I

Cancel |

Oostart| | 3, m @

| 28 Adminitrator: Command. .. | [ Citrix Access Manage...

I
ERENIC




DEPLOYMENT GUIDE | XenApp, Amazon EC2

Mlerts
[T search Results
My Views
[T report Center
[ Licensing
[ Diagnestic Fadiity
Bl (3 Gitrix Resources

CITRIX

] Citrix Access Management Cor [ eE g e e 1)

Type
View the application type. To change the type, use the Change application type task.

Choose the type of application to publish.

CiTRIX'

Choose columns

= [ Configuration Tools Steps
Web Interface " Server deskiop
Hotfix Managemen ~
& B xenaop Content
B £8 NewFarmMame Qe
& Administrators
B (2 R ~pplication type
e Excad Location 5 Accessed from a server
04 outiook
P2 Powerpairt Servers " Streamed if possible, otherwise accessed from a server
Word Users Server application type:
2 [ servers Shorteut [instaled sppircation =
1 xas presentation
[ xasz2
@ [ Zones Publish immedistely Fa Loy
Password Manager

() Nete Tochange the applicati af the Change Appli
Typetask
GQuick Help
Grants users access to 2 single application akready installed on your servers.
<Back | Mexs Cancel_|
CIT|
Oostart| | ZomE @ | [ Administator: Command... |[[] Gitrix Access Manage...
8 R p =
ox A anage onso _[B]x
Fle  Acton View Help
+= | 2m | E
Citrx Access Management Cor plorer - Publish Applicatio <

Mlerts
[ search Results
My Views
[T report Center
[ Licensing
F] Diagnastic Fadiity
=l [3) Citrix Resources
[ [ Configuration Tools
@] Web Interface
Hotfix Managemen
= 8 xenApp
£l B8 NewFarmiame
& Administrators
= [ Applications.
o Excel
0 outlook.
[Pz Powerpoin
word
& [2 servers
[ xas1
[# xas2
[ Zones
assword Manager

CiTRIX'

Location
Select and configure the resource being published

CITRIX'

Enter the application location
Steps

. i i
default werking directory for users. More.

you want to publish. You can also specify a

Publish immediately

Basic Command line
Name ["e-\program fies\Intemet Bxploreriexplore exe”
»  Location )
\orking directory:
Servers [e?erogram fies\Intemet Explorer
Users
Browse.
Shortcut
presentation

Choose columns

Drstart| | om @&

| [ Administrator: Command. | D] Gitrix Access Manage...

S

Publish Applications:

Run it from this server.

Publish Applications:
Provide the execution path.
Use the Browse button.
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Publish Applications:

Run it on the XenApp Server 2
- XAS2.

Publish Applications:

Specify the users who can
access this application.

File Acton View

|
e L s Tl Tnternet Explorer - Publish Application (5/8) x|
Alerts . "
[ Search Resuits CITRIX
My Views
Report Center Servers
5] Licensing e iz s anrare will ks e are

[+] Diagnostic Fadiity
& (3] Citrix Resources
) 2 Configuration Tools
] Web Interface
Hotfix Managemen
& B3 xenapp
= §§ NewFarmName
&3 Administrators
& [} Applications.
i Excel
[0 outiook
P2 Powerpoin
Word
& (5 servers
[ xas1

=l xas2
(% Zones
Password Manager

Steps | Lookin:  [[SiSewers | «mBE-| -

[ ad. | e

Select Servers [ <]

CITRIX

Choose columns

2

[=1xAst Add o
[ ZIxasz
v Ty
v Lo I= | Include subfolders
Se
Selected items
Ust
e [ Mame [ Location [ Rermove
“Ixas2 MewFamMName/S:
e @ enFamName/Servers —
Publis

0K Cancel ﬂ
Import from file...

Remeiel|

<Back | WNea> | Cancal |

CITRIX' |

Oostart| | 3, om0 @

| B8 Administrator: Command... | [8] Citrix Access Manage...

#3 184.73.214.55 - Remote Desktop.

P Citrix Access Management Console

Gitrix Access Management Cor

Alerts

[[] Report Center
(] Licensing

[+] Diagnostic Fadility

CITRIX

Users

Configure the users who may access the application

CiTRIX'

Choose columns

& (3 Citrix Resources

H 5 C Toals

Specify the users who can access this application.

] Web Interface
Hotfix Managemen
& B3 xenapp
= B8 NewFarmiame
&3 Administrators
& [} Applications.
& Excel
[0 outiook
P2 Powerpoin
Word
& (B servers
[ xas1

=l xas2
(% Zores
Password Manager

Toadd users. choose a directory type at the botiom and select Add. More.

£ Allow ancnymous users
' Allow only configured users
Corfigured users

&5 Domain Admins (CITRIXLABS \Domain Adins)
&5 Domain Users (CITRIXLABS\Domain Users)

Shorteut
presentation

Publish immediately

Select directory type: | CHix User Sefector =l

<Back | Nea> |

] |mm & |

B Administrator: Command. .. | [4] Gitrix Access Manage...
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File Action View Help

€= FmdmR

Publish Applications:

Use the default IE icon.

ers ITRIX CITRIX
G search Resuits CITRIX 1
My Views -
[T Report Center Shorteut presentation ..
() teenorg Finish.
[ Diagnestic Fadiity Choose columns
El (3 Citrix Resources — — o
B @ C Tods | Steps Colas i
] Web Interfce | 200 These seftings function differently on different clients. More.

Hotfix Managemen
5 @ venspn

B £8 NewFarmName

~ Appiication icon

Repeat the Publish Application

lcon: f ) Change icon... . .
iy T | e procedure for each Application
géﬁiﬂ“ ‘ e you want to publish, for
Powerpoin
E@n:.usrd : i:j;‘ (- Application shartcut placement example NOtepad’ Word pad’
g wr preseniation I~ Add to the clients Start menu Calculator’ etc.

[ Zones
Password Manager

Publish immediately

Start menu folder (Citrix XenApp plugin only)

I | Place under Programs folder (Citrix Xenfipp plugin only)

™ Add shortcut to the client's desktop.

<Beck | MNext> | Concel |

CiTRIX' |
I

Cistart| | G M @ | @R Administrator: Commend... [ Gitrix Access Manage... Bo0 sh
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Web Interface:

On the Web Interface server,
open the Web Interface
Management Console.

Select Server Farms.

Web Interface:

Add the XenApp Server to the
farm.

CiTRIX

XenApp Configuration

Web Interface Farm

Web Interface needs to be configured.

[ Citroc Web Interface
XenApp Web Sites

% XenApp Services Sites

7] XenApp

Summary Secure Access |
- )

L B

Translated

= NAT firewall using
Atemate IL b— akemate address

NAT firewal using
)

Gateway - F -

L it '—F
Gateway F
Trenslated

——

Gatsay F D HAT frewsll using
Altemate atemate address
——

map
speciied below

Nontranslating
frewall

NAT firewall using
translation map
speciied below

~¢|

Edi

@ Default access method

Actions

XenApp Web Sites -
Create Site
View »
6] Refiesh
Help »

XenApp - Edit Settings -
Server Farms
Authentication Methods
Web Site Appearance
Secure Access
Resource Types
Client Deployment
Client-Side Proxy
Session Preferences
Workspace Control
Site Maintenance »

Preview Site

H tep

Configure server farm details for the selected site.

[ [
Costart| | 3 M @ @ | @ cbixXenaoo - Lo... [ @ Citrix Web Inter... [§ Secure Gateway 3.2 3 Secure Gateway 3.2| 3 Internet Informati... | @) Gtix Xenaop - 80...| [ &z

[ Citric Web Interface

XenApp Web Sites

YenApp Web Sites
XenApp Services Sites

Sie name [ Site URL

| & XenAep http.// W1 ctidabs com/Cie/XenApp

Famname: [Fam1

Edit Farm [x]

M Sel Fi

Add and edit farm n. Servers (in failover onder).

and SSL server por xas citiidabs com

Farms (n change p:
@ Name XML
Fam1 8080
Sum

M. | e |

Move Up

Move Down

Remove |

I Use the serverlist for load balancing

- E Bypass any falled serverfor
—I C ion Settings

Advanced Setting
Configure socke

XML Service port: 8080

Transpottype:  [HTTP
SSLRelaypor: 443
Ticketing Settings

Atemate !

Gateway
Transialed i

Configure the lifetime of client authentication tickets.  Tickefing Seftings.

Cancel

ETET

||_I:I

Edit secure access seftings.

@ Defaut access method

Actions
XenApp Web Sites -
Create Site
View »
|6 Refresh
Help »

XenApp - Edit Settings 2
Server Farms
Authentication Methods
Web Site Appearance
Secure Access
Resource Types
Client Deployment
Client-Side Proxy
Session Preferences
Warkspace Control
Site Maintenance »

Preview Site

Help

Configure server farm details for the selected site

Crstart| | 5 M @ @ | @ ntemetExplorer .. [ (@) Citrix Web Tnter... [ Secure Gateway 3.2 [ Seare Gateway 3.2| 4 Intemet Informat... |

[
@ ot xenagn - 0. | [ i
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Secure Access

Web Interface Secure Access needs to be configured.

Secure Access: e .

Web Interface Management

Fie Acon View Help

On the Web Interface server, rTEEE
Citrix Web Interface = a
Manegement Consoie, === =
Select Secure Access. E s ’
e s

Server Farms
Authentication Methods
Web Site Appearance
Secure Access

a Resource Types

Client Deployment
Client-Side Proxy

Session Preferences

== NAT firewall using

Atemate i '—ahemateaddress
= ] 1 NAT fiewall using

Translated i ] translation map
2 I speciied below

Workspace Contral

Site Maintenance 3
- Freview Site
) Gateway e Nonranslating
Direct - < firewall H rep

Gateway > g NAT frewall using
Aemats i shemate address
Gateway = s NAT frewal using
Translated translation map
specfied below

Edit secure access seftings @ Defauit access method =

[ I
Lrstart| | 2 M @ @ | @ cixXenaop -Lo... |[ (D Citrix Web Inter... 4] Secure Gateway 3.2 | [ Secure Gateway 3.2 | ¥ Intemet Informati.. | (@) Cirix XenAop - Ao,

BaEEN

secure Access: A - Remote Deskt:

Change the access method to

i Citrix Web Interfa ” Actions
Gateway Direct. CERR XenApp Wb Sites
Xenpp Web Sites XenApp Web Sites .
XenApp Services Sites B [ Sie URL [
| B xenApp hetp:// W1 ctidabs com/Ctroc/XenApp Create Site
View »
CIiTRIX o
l H rep »
‘Specily Access Methods XenApp - Edit Settings A
Server Farms.
Authentication Methods
Specify details of the NM7 seffinas._incliding IP address_mask_and associat
L2 T it Default Route for all User Devices =] Veb Site Appearance
User device Secure Access
Summaty  ————  Specily the type of rouie to use if the user device address
o [Paddess does not match one of the explicitly defined rules. figre A Resaurce Types
Defauit
. Erer— - Client Deployment
Ate Client-Side Proxy
oK Cancel Session Preferences
. Workspace Control
& T |
i | = Hemove | Site Maintenance »
Preview Site
@ G
Dire H tep

Gat
Ate Next > Cancel
. =)
Gateway = s NAT frowall using
Tandated ranslaton mep
specified below

selfings @ Default access method

Edit secure ac

Kl

|Configure DMZ settings, gateway settings, and address translations |

Costart| | 3 M @ @ | & GirixXenaop - Lo... |[(D Gitrix Web Inter... [fd Seare Gateway 3.2 | [ Secure Gateway 3.2 | ¥ Intemet Informati.

[
@ cirixxenton - 0... [ @I
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Web Interface Management

File Action View Help

Specify Gatoway Settings

Specify gateway server details for any user devices that access this site through
B Xens theAccess Gateway or Secure Gateway. bore

Address (FQDN):  [wi ctrdabs com

Summary
T por faz
¥ Enable session reliabity

g I~ Request tickets from two STAs, where available
i

9
Dir
Gat <Back Next > Cancel |
Bte

— =
Gateway = e NAT firewall using
Trenslated i transiation map
= specfied below

€= [Fmldlm
[ Citrix Web Interface " Actions
[
R XenApp Web Sites o web
XenApp Services Sites T [ Ste URL
YenApp hitp://WI.citridabs.com,/Citrie/XenApp Create Sit=
View r
CiTRIX' S
! H e »

XenApp - Edit Settings
Server Farms
Authentication Methods
Web Site Appearance
Secure Access

;I Resource Types

Client Deployment

Client-Side Proxy

Session Preferences

Workspace Control

Site Maintenance

Preview Site

H rep

Edit secire access seftinas @ Defauit access method

Configure DMZ settings, gateway settings, and address translations.

Oostart| | m & @ | @Omxxeﬂﬂw-wml (D Gitrix Web Inter... Secure(iatewayﬁ.zl (¥ secure Gatewayizl 'qﬁlntemetlnﬁxmahu.l (@) Gitrix XenApp - Ap...

2318 197.3 - Remote Desktop.

¥ Citrix Web Interface Management

File Action View Help

Specify Secure Ticket Authority Seffings

Specify gatewav server details for anv user devices that access this site throuh
5 Xent L] Fdit Secure Ticket Authority URL

Sy Secure Ticket Authority URL
Y. Secur1 (Cirix recommends using FGDN for server names).
Ate
T add. [[ Ear. | Remove |

I~ Useforload balancing

Gat
D o Bypasaled seversfor T = [Hous -

Gat cBack | Frsh | cancel |

Alte

- T
Gateway > F e NAT firewall using
Translated translation map
= specfied below

€= [Fmldlm
(D Citrx Web Interface " Actions
g
e XenApp Web Sites o web N
Xenhpp Services Sites T [ ste URL
XenAop Hito://WI.citodabs.com/ Ciee/Xen/op Create Site
View L3
Edit Secure Access Settings - XenApp x|
CiTRIX' S =
! [ ree »

XenApp - Edit Settings
Server Farms
Authentication Methods
Web Site Appearance
Secure Access

E Resource Types

Client Deployment

Client-Side Proxy

Session Preferences

Workspace Cantral

Site Maintenance

Preview Site

H rep

Edit secure access settings @ Defauit access method

Configure DMZ settings, gateway settings, and address translations.

rstart]| | %m0 @ @ | @ citixxenapp -Lo.. |[{D Gitrix Web Inter... [{] Secure Gateway 3.2 | [{] Secure Gateway 3.2 | 9 Interet Informet. .| (@) Cirix XenApp - Ap.

Secure Access:

Specify the FQDN of the Web
Interface server.

Secure Access:

Enter the Secure Ticket
Authority, which is running on
the backend XenApp Server.

Note: Repeat this step for the
XenApp Services Site.
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XenApp Secure Gateway

Secure Gateway needs to be configured.
secure Gateway: #% 184.73.197.3 - Remote Desktop

EEX
IS Secure Gateway 3.2 |- [=]x]
Fie Acton View Faverites Help
Open the Secure Gateway T EEIE L Tl E I DT

Management Console.

[ secure Gateway

= %] secure Gateway Management Console
Session Information 8 Secure Gateway Management Console
1+ =} Secure Gateway Performance Statistics
Start -> All Programs -> Citrix .

_> Management ConSOleS _> L‘@SEU\JEG&EWE Configuration @52&4’2 Gateway Diagnostics
Secure Gateway Management
Console.

Select Secure Gateway
Configuration.

% Secure Gateway Management Console A Standard /

I [
Costart| | % m @ @ | @& ovxenten -Lo... | () Gtrix Web Interfa... [ Secure Gatewa.. |7 Seare Gatenay 3.2 | 43 Intemet Informati.. | @) Gtricxenaoe - A...| [ 3L

Secure Gateway: #% 184.73.197.3 - Remote Desktop

EEX
[ secure Gateway 3.2 mEE
File Action View Favorites Help
Select Advanced. TG AE]> & 1w

[ secure Gateway

Secure Gateway Management Console
= %] Secure Gateway Management Console
Session Information 2 secure Gateway Management Console

+1!) Secure Gateway Performance Statistics

|Secure Gateway Configuration wizard [x]
e
Secure Gateway configuration level for Citrix XenApp

CITRIX oo

" Standard

Configure typical Secure Gateway
parameters,

% Advanced

Configure all parameters for the Secure
Gateway.

< Back I Next > I Cancel Help

%__Secure Gateway Management Console A Standard /

I [
Crstart| | 5 M @ @ | @ ctrixxenaop ... | (D Girix Web Int... | [ Secure Gatew... | [ Seare Gatew... | ¥ IntemetInfor... | @) Gtrix xenagp ... |[#9 Secure Gate.. | ) w3l




DEPLOYMENT GUIDE | XenApp, Amazon EC2

#3 184.73.197.3 - Remote Desktop.

F= secure Gateway 3.2

[Fie acion vew Fovs bp
=2z He BRE > = 0 p o

Secure Gateway Management Console

E® secure Gateway Management Console

[ Secure Gateway
Secure Gateway Management Console
'] Secure Gateway Performance Statistics

Secure Gateway Configuration wizard [x]

e e

CiTRIX'

Select a server certificate

The following server certificate(s) were found on your
system. Please select the server certficate to be used
by the Secure Gateway.

To view certificate detais, select an entry in the list and
dlck View.

Certificates found

View...

% Seare Gateway Management Console {_ Standard /

Orstart]| | 3 0 @ @ | [fgseare Gateway 3.2 |[%2 Secure Gateway Confi.. « Wyl

%% 184.73.197.3 - Remote Desktop

E= Secure Gateway 3.2

Fle Acton View Favorites Help
P EEN I I

Secure Gateway Management Console
[ [#] Secure Gateway Management Console
Session Information [ Secure Gateway Management Console
£ Secure Gateway Performance Statistics

Secure Gateway Configuration wizard

CiTRIX'

[ Secure Gateway

Configure secure protocal settings
[ Selectseareprotocol ——

€ Transport Layer Security (TLSv1)

% Secure Sockets Layer (S5Lv3) and TLSv1

[Selectcpher sute —————————————————————
© Gov

 com
& Al

<Back I Next > I Cancel Help

Y Seaure Gateway Management Console 4 Standard /

I I
Orstart]| | 3 m @ @ | @ citioxenapp .| @ abixweb Int... | 4 Secure Gatew... | (4] Secure Gatew... | ¥ nternet Infor.. | (@) cirix Xenapp ... | [ secure Gate. | =) ®¥Ils

Secure Gateway:

You would have to have

a certificate signed by a
Certificate Authority, and
imported into the Certificate
Store on the Web Interface
server.

There are two options:

1) Install a bona-fide certificate

issued by a Certificate Authority.

2) Install Certificate Services
on the Domain Controller and
create a self-signed certificate
for the Web Interface server.
You would then need to import
the CA root certificate, from
dc.citrixlabs.com, into the
clients browser.

(We did #2 for this proof of
concept).

Secure Gateway:
Use the defaults.
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Publish Applications:

We have installed Microsoft
Office 2010 on the first
XenApp Server (xas1.citrixlabs.
com), and will publish those
applications.

Open the Access Management
Console.

Publish Applications:

Select Applications -> New ->
Publish Application.

CiTRIX

XenApp Applications

Publish Applications XenApp Server 1

Once the XenApp Server is installed, you need to “publish” applications that
you want your users to access and run.

#3 184.73.213.224 - Remote Desktop

agement Console

Fie Acion View Help

Eaﬁla\%mm
Citrix Access Managsment Console = . 2 -
Alerts * @ Lﬂ @ = Applications CITR!X

] Search Resuits Home My Views Search

My Views [ Contents
[T] Report Center Common Tasks

[ uicensing Changedisplay 4

[ %] Diagnostic Fadility
& (3 Citrix Resources
I B Configuration Tools Save in My Views
Web Interface
Hotfix Management

New ¥ |} |- There are no items to display.

=] B XenApp ‘Other Tasks
= 22 NewFarmName Customize display »
&3 Administrators Permissions
] o0 5 Impart new applications from a
B [ servers file
=l XAs1
B 2 Zones
< Default Zone [Betated Kook R
Password Manager XenApp Advanced 0
Configuration Toa <J

Citrix Knowledge Centers

0items

5 Launches exizmal appiczton

CITRIX'

Costart| | 5, M @ | 8] Gtrix Access Manageme... |[[] Citrix Access Manage... [ Administrator: Command... «@ "

Remote Desktop

agement Console

Action  View  Help

@ 5| |

Citrix Access Management Console = = . .
[ I = . .

Alerts @ [ [5 Applications CITR!X

] search Resuts Home My Views Search
My Views E Contents
@ Report Center e
Licensing
- Changedispl
[#] Diagnostic Facility angedisplay
= (3 Citrix Resources Hew Publish application to display.
Bl B2 Configuration Tools Save in My Views Create folder
@] Web Interface

Hotfix Management s
El App el

NewFarmiame Customize display 3

& Administrators Permissions

Applications Import new applications from a

Bl [ Servers ile
[ xas1
Bl [ Zones
< Default Zone Related Tools
Password Manager XenApp Advanced N
Configuration Toaty <J
Citrix Knowledge Centers
0 items

[ Launches extemal applieation

CITRIX'

I [
Lrstart| | % m @ |3 Microsoft Mana. - B Administrator: Comm.. | system32 # Computer | _# professional [«@o@ @b
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_[&[x
File Action View
&= 5
Herts Cm— CITRIX
Search Resuits CITRIX I
My Views
[T] Report Center Name

[ Licensing
[ Diagnestic Fadiity
El (3 Citrix Resources

T Tocls Enter the that you want to be to clients for this application.
@ Web Interface D
Hotfix Managemen Display name

= B xenaon
B £8 NewFarmName
& Administrators

[Word

[ Applications Application description:
& [ servers Location [Microsof: Worl
[# xas1
E [ Zones Servers
S Default Zoy Users
2 r d M:
assword Manager ot
presentation

Publish immediately

<Back [ Newt> Cancel_|

RIX

I
Oostart| | 3 m @ |[[@ 3 Microsoft Mana...~ [ Adninitrator: Comm... | £ system32 # Computer | _# professional

I
@@ S

File Action View Help

€= FmdmR

Ll Citrix Access Management Cor [t e
Mlerts

.
Search Results CITRIX
My Views

[T] Report Center Type

[ Licensing
[ Diagnestic Fadiity
El (3 Citrix Resources

View the application type. To change the type, use the Change application type task.

B Tools Choose the type of application to publish.

@ Web Interface (" Server deskiop
Hotfix Managemen ~
5 BB venaop Contert
1 E8 NewFarmiame I Yoeelicotion
& Administrators
[ Applications ~Application type
& [ servers Location 1% Accessed from 2 server
£l XAs1
aE® Eﬁm Servers £ Streamed if possible, otherwise accessed from a server
< Default Zor Users Server application type:
Password Manager Shorteut [instsld appication =l
presentation
Publish immediately Y

0 Note: To change the applicati aft ishing i the: Chi Appli

Typetask

Duick Help
Grants users access to a single application akeady installed on your servers.

<Back [ Newt> Cancel_|

I
Oostart| | 3 m @ |[[@ 3 Microsoft Mana...~ [ Adninitrator: Comm... | £ system32 # Computer | _# professional

I
@@ S

Publish Applications:

We will publish Microsoft Word
as an example application.

Publish Applications:

Application will be accessed
from a this server.

80



81

Publish Applications:

Specify the command line to
launch the application:

c:\program files\microsoft
office\Office14\WINWORD.EXE.

Use the Browse button to
locate the application.

Publish Applications:

Run it on this server.

ix Acce g onso NE D
Fie Action View Help
&= 2 E
(ST e TR R Word - Publish Application (4/8) [x] 3 o

Herts ITRIX CITRIX

[ Search Resuits CITRIX 1

My Views

Report Center Location
-] Licensing Select and configure the resouree being published.

[+] Diagnostic Fadiity
& (3] Citrix Resources
H 5 C Toals

Steps

Enter the application location

] Web Interface
Hotfix Managemen
& B3 xenapp
= §§ NewFarmName
&3 Administrators
(=} Applications
B (5 Servers
[ xas1
B 2 Zones
7 Default Zat
Password Manager

Name

v Type

> Location
Servers
Users

Shorteut
presentation

Publish immediately

the e

Enter lication y to publish a
default working directory for users. More.

‘Command line:

"c:\program files \microsoft office\Office 14\WINWORD EXE"

ilorking directory:
[o\program files'\miorosoft office\Dfice 14

Browse.

#3 184.73.213.224 - Remote Desktop.

P Citrix Access Management Console

<Back | WNea> | Cancal |
T .
CITRIX
[
Costart| | Zom @ |[[@3 Microsoft Mana.. - B Administrator: Comm... | 7 system32 # Computer | # professionsl

Citrix Access Management Cor

Alerts

Search Results

[[] Report Center
(] Licensing

[+] Diagnostic Fadility

CITRIX'

Servers

Configure which servers will host the application

CiTRIX'

& (3 Citrix Resources

[ | Choose the servers on which this published lication will run i ia ICA.
Bl B2 C Tools Steps
G Web Interface S
Hotfix Managemen Name [ Relative location [ Application location
£ 23 xentpp XAS1 Servers Defaul
= lewFarmName
&3 Administrators
(=} Applications.
& (5 servers
[ xas1
B [ Zones
< Default Zor Users
2 r: d M
assword Manager Shoreut
presentation
Publish immediately
4 |
1item
Ad. || Edt Impart from file..
<Back | Net> | Cancdl |

Dostart| | o @&

|[@ 3 Microsoft Mana... - [N Administrator: Comm... | ¥ system32

# Computer | _# professional
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File Action View Help

-8

e 37 @
J Citrix Access Management Cor [T pIa e T e ] [<]
Mlerts . -
G search Resuits CITRIX
My Views
[T] Report Center Users
5] Licensing Configure the users who may access the application
[ Diagnestic Fadiity

CiTRIX'

El (3 Citrix Resources
= 12 C Taols
@ Web Interface D
Hotfix Managemen
= B xenaon

B £8 NewFarmName

Specify the users who can access this application.
To add users, choose a directory type at the bottom and select Add. More.

v
& Administrators ® e _—
[ Aoplications | ¥ o
= [ servers v ' Allow only configured users
[# xas1
= [ Zones ¥ Servers Configured users:
57 DefadtZo | »  Users &5 Domain Admins (CITRIXLABS\Domain Admins)
B d M
assword Manager Shorteut &5 Domain Users (CITRIXLABS\Domain Users)
presentation

Publish immediately

Select directory type: | Cirx User Selector =

Remave

<Back | MNet> | Concel |
g 3
CITRIX
I I
Oostart| | 3 m @ |[[@ 3 Microsoft Mana...~ [ Adninitrator: Comm... | £ system32 % Computer | _# professional [«@o@ &b

File Action View Help

e | a
0 ﬂm( Access Management Cor (e e [x]
[ aerts 0 .
CITRIX

My Views
[T] Report Center
[ Licensing

[ Diagnestic Fadiity

(] search Results
Shortcut presentation

El (3 Citrix Resources
= 12 C Taols
@ Web Interface
Hotfix Managemen

Configure the and location of the:

These settings function differently on different clients. Mere.

2 [ xenaop i~ &pplication icon
v I Change icon...

& Administrators s Aot
[ Aoplications | ¥

=] Servers
@Lﬂ ast v Client application folder

=[5 Zones v [

< DefaultZor | Users
Password Manager . Sho [~ Application shortcut placement
presentation ™ Add to the client's Start menu

Publish immediately I= | Place under Programs fo

der (Citrix XenApp plugin only)

Start menu folder (Citrix XenApp plugin only)

™ Add shortcut to the client's desktop.

<Back | MNet> | Concel |
g 3
CITRIX
I I
Oostart| | 3 m @ |[[@ 3 Microsoft Mana...~ [ Adninitrator: Comm... | £ system32 % Computer | _# professional [«@o@ &b

Publish Applications:

Specify the users who can
access this application.

Publish Applications:
Use the default MS Word icon.

Finish.

Repeat the Publish Application
procedure for each Microsoft
Office 2010 application that you
want to publish, such as Excel,
Powerpoint, Outlook.
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Publish Applications XenApp Server 2

Once the additional XenApp Server is installed, you need to join the server
farm on XenApp Server 1, and “publish” applications that you want your
users to access and run.

Change Farm: #3 184.73.214.55 - Remote Desktop

| Administrator: Command Prompt

Microsoft Windows [Uersion £.8.60021 i

On the XenApp Server 2, open Copyright (:? ZIBG Microsoft Corporation. A1l rights reserved.
H rs\Adninistrator>ehfarn

a command prompt, and run o Usorsnadniniobratoss_

chfarm.

Join an existing farm.

#% 184.73.214.55 - Remote Desktop:

8 Gitrix XenApp

Server Farm Selection

ciTll!X' Choose to create a new server fam or join an existing one:

F you choose to create 3 new serverfam, this server becomes the first
server in the fam.

" Create anew fam

¢ Join an existing famm

#% 184.73.214.55 - Remote Desktop
Join Farm: E

If using an Access Database in
the Farm, choose the second
option, Connect to a data
store set up locally on another

computer. 7 snerom

Specify the Server Name that CITRIX' | Crtmmboomeceniote s e
hosts the Server Farm. In this Farsmver =]
example, it is on XenApp Server £ Comt s st uplecal n st com
1 - xas1.citrixlabs.com. S —

Zone Name
¥ Use defauk Zone Name

[

Costart| | S M1 @ | @ Adminstrator: Commend... |77 Citrix XenApp (DO

:
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‘t!1|!4.73.214.557 Remote Desktop Lad) Join Farm:

Provide credentials.

Indirect Server Login
., . Inthe fields provided, enter the user account information required
CITRPC | ot

Server Name

cas 1 citridabs com:2512

User Name.

[administrator

Password

Domain Name:

[etrodabs. com|

Orstan] | 3, m & | i@ Administrator: Command... || 77 Citroc xenapp EL0)

%3 184.73.214.55 - Remote Desktop Join Farm:

Use Global Farm Settings.

License Server

H . " Pointto an exsting license server.
CiTRIX

Please erterthe name orthe IP address of the Citrix License Server.

License Server Name:
License Server Port ¥ | Use default port

€ {llse the global fam settings for the license server}

" Ido not know the license server. | will enter it later.

if you do not know the niame or the IP address cf the Gitix License.
Server, you can enter tlater throuh the Access Management
Console.

< Back I Finish I Cancel

Crstart| | G, Mm@ | @6 Adnistrator: Commen
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Secure Gateway:

Monitor all IPv4 addresses.
Use port 443.

Secure Gateway:

Continue.

CiTRIX

#3 184.73.197.3 - Remote Desktop

[ secure Gateway 3.2

Fie Acton View Favorites Help

] secure Gatenay
=1 [[#] Secure Gateway Management Console
Session Information
+) Secure Gateway Performance Statistics

2 secure Gateway Management Console

Configure inbound dlient connections.

The Secure Gatenay listens on the specified IP
address(es) for inbound dient connections.

L)
CITRIX
[ Wonitor all IPv4 addresses.
= tnenitar &l (Py5 addresses
TP port: [ EEE
face list

addl | [medfyi | et

%__Secure Gateway Management Console A Standard /

Lrstart| | 3 M @ @ | @ Gtricxenaon ...| @ aitrix Web Int... | [ seaure Gatew... | [ secure Gatew... | 43 Internet Infor... | @) Cirix Xenaop ... |[ 3 Secure Gate. | ) WY

#3 184.73.197.3 - Remote Desktop
[ secure Gateway 3.2

Fie Acton View Favorites Help

] secure Gatenay

=1 [[#] Secure Gateway Management Console
Session Information

+) Secure Gateway Performance Statistics

Secure Gateway Management Console

2 secure Gateway Management Console

Configure inbound dlient connections

Secure Gateway listens on the spedified IP

. The
clT.Ix- addressfes) for inbound dient connections.

|Secure Gateway Service Configuration

A One or mare of the IP addresses is a dynamic IP
address, If this IP address changes, existing
connections are lost and new connections are
not accepted untl the Secure Gateway is
reconfigured with its new [P address. Itis
recommended that you configure Secure
Gateway with static [P addresses.

Click Continue to use the selected dynamic IP
address or dick Back to select a static IP Delete
address.

%__Secure Gateway Management Console A Standard /

Lrstart| | 3 M @ @ | @ Gtricxenaon ...| @ aitrix Web Int... | [ seaure Gatew... | [ secure Gatew... | 43 Internet Infor... | @) Cirix Xenaop ... |[ 3 Secure Gate. | ) WY
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%3 184.73.197.3 - Remote Desktop L (X secure Gateway:

[ secure Gateway 3.2

File Acton View Favorites Help . .
No outbound restrictions.

® = [ #i[ml

ecure Gateway

1 [#] secure Gateway Management Console
Session Information

+1') Secure Gateway Performance Statistics

& Secure Gateway Management Console

Secure Gateway Configuration wizard
P e

Configure outbound connections

ciTRlx. Outbound connections

% No outhound traffic restrictions

™ Use the Secure Gateway Proxy

Configire. .

™ Use an Access Control List (ACL)

Corfigure. .

Y, Secure Gateway Management Console & Standard /
[ I
lostart| | 3 E@ | @Cimx)(eﬂlppml eomxwd:m”.l | Secure Gatew”.l |7 Secure Gatew... | ‘qﬂlntemetmfor.ul wﬂmx)teﬂApp‘.‘l ¥ secure Gate.. [(2) ®3

#3 184.73.197.3 - Remote Desktop.

z Secure Gateway:
T bt T A Add the Secure Ticket Authority

==
& Seare Gy for the XenApp Server. The STA
e — is on the XenApp Server.

Secure Gateway Configuration wizard x|

Details of the server running the Secure Ticket Authority
£

(ST
o . (et pe e dns s e i s
clTR STA. Configuring multiple STAs provide failover
protection,

Servers running the STA

Identifier
STA16F2DB119448

Secure Gateway Configuration wizard

~Secure Ticket Authority (STA) detals

FQDN:
Path: [ iseripts/cixsTa.dll
: STA16F2D3119448

[ Protocol settings:

r Secure traffic between the 5TA and the
Secure Gateway

TCPport: |anso I~ Use defaut

[ ok | coneel Help

<Back Next >

Y, Secure Gateway Management Console & Standard /
[ I
lostart| | 3 E@ | @Cimx)(eﬂlppml eomxwd:m”.l | Secure Gatew”.l |7 Secure Gatew... | ‘qﬂlntemetmfor.ul wﬂmx)teﬂApp‘.‘l ¥ secure Gate.. [(2) ®3
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Secure Gateway:

Access Options. Users will
connect to the Secure Gateway
indirectly, installed on this
computer.

Secure Gateway:

Restart Secure Gateway.

CiTRIX

#3 184.73.197.3 - Remote Desktop

[ secure Gateway 3.2
Fie Acion View Favorits Help

] secure Gatenay
=1 [[#] Secure Gateway Management Console
Session Information
+) Secure Gateway Performance Statistics

2 secure Gateway Manag:

|Secure Gateway Configuration wizard [x]

Details of the server running the Web Interface

2 L] [~ Access
ClTRlx % Indirect: To access the Web Interface,

users enter the URL of the Secure Gateway.
[¥ Installed on this computer

" Direct: To access the Web Interface, users
enter the URL of the Web Interface.,

[ Detail
Foo:  [localhost
Secure traffic betyeen
TCPport: | 50 I e #ieh Tniterface and

the Secure Gateyay

%__Secure Gateway Management Console A Standard /

I [
Lrstart| | 3 M @ @ | @ Gtricxenaon ...| @ aitrix Web Int... | [ seaure Gatew... | [ secure Gatew... | 43 Internet Infor... | @) Cirix Xenaop ... |[ 3 Secure Gate. | ) WY

#3 184.73.197.3 - Remote Desktop
[ secure Gateway 3.2

] secure Gatenay
=1 [[#] Secure Gateway Management Console
Session Information
+) Secure Gateway Performance Statistics

|Secure Gateway Configuration wizard [x]

Secure Gateway configuration complete

L)
C|TRlx' Secure Gateway is currently running.
The configuration wizard wil restart the Secure Gateway
for changes to teke effect.

Warning: every existing connection will be dropped.

[V Restart Secure Gateway

< Back liExt > | Finish I Help

%__Secure Gateway Management Console A Standard /

Lrstart| | 3 M @ @ | @ Gtricxenaon ...| @ aitrix Web Int... | [ seaure Gatew... | [ secure Gatew... | 43 Internet Infor... | @) Cirix Xenaop ... |[ 3 Secure Gate. | ) WY




DEPLOYMENT GUIDE | XenApp, Amazon EC2

88



89

Remote Test:

On the remote client machine,
launch a web browser.

Try connection to the secure
and non-secure Web Interface.

http://wi.citrixlabs.com

https://wi.citrixlabs.com

You may need to make an entry
in the Client’s “hosts” file, if
DNS isn’t configured to resolve
the Web Interface address yet.

Remote Test:

The published apps should
appear enumerated in the
browser.

CiTRIX

XenApp Remote Test

Testing the XenApp installation remotely

Once all of the servers are built and configured, you should test the installa-
tion remotely from a client machine.

it View Higtory Bookmarks Took Help

@ - C (O nwosi .ot 2T Front. :

£ Most Visited _| Getting Started

Latest Headlines

@ Citrix XenApp - Logon

Welcome

Log on to access your applications.

name:

omain:

Done

B @@ | @ mtemetexplorer ... | (@) citri web nterfa... | [7 Seaure Gateway 3.2 7 secure Gateway 3.2| 63 ntemet Informat... | [{@) Gitrix XenApp - - | &

Lrstan| | 2y

#% 184.73.197.3 - Remote Desktop.
&) Citrix XenApp - Applications - Mozilla Firefox
File Edit View Hstory Bookmarks Tools Help

@ - e & NOEEETES htis: jwictrisiabs. com/c defauit,asp - [*-Teo0ae »

£ MostVisited || Getting Started

Latest Headlines

© Citrix XenApp - Applications

CiTRIX

Applications Preferences v

Logged on as: administrator

Applications \

Selectview: [Tcons -]
1 i (P (wed

Calculator Internet Explorer Hotepad Outlook Powerpoint Word

|

Wordpad

Hint: Unable to find the resource you need? Use Search to locate it foryou. [

Done [a
['5tart| |Z2mE@ | ;@Inh&metExplvEr.ul (D Citrix Web Inhen’a.‘.l | ¥ secure Gateway 3‘2| % secure Gateway 3.2| ¥ Inhemallnfmmahml @ atrocxenapp - () Wil
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tems - Virtualization, Networking and Cloud. Simplified. - Windows Internet Explorer - | l:llil
% L ._':.' http:f/dtrix.comlang/English/home.asp j ‘§| ‘T,| ‘;| I:f Live Search |}J '|
i} Favorites {;‘3 @ Suggested Sites ~ @ | Web Slice Gallery ~
:'_- Citrix Systems - Virtualization, Netweorking and Cloud. ... | | & hd = [ @ ~ Page~ Safety ~ Tools » @'
H L]
CITR!X Products & Solutions Downloads Support Partners
Synergy Desktops Servers Networks Collaboration

Three critical techno
One essential event.

Don’t miss out.

Register now! ©

CITRIX MEWS HEADLINES Citrix Desktop Virtualization Helps MASA Astronauts Stay in Touch with Family and Friends from Space

- -
4« | 3

htto: /. citrixsyneray.com/ [ [ [ [ [ @ miemet|rrotected Mode: OF 5 [Rww -

Remote Test:

Open one of the applications
and it should be delivered to the
client - from the XenApp Farm
running in Amazon EC2.
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